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Introduction
What's in This Book
This reference manual provides detailed information on how to install, configure and administer
WebDocs. Here is what's included in this book.
· Chapter 1 - Introduction: describes this reference manual and how to use it effectively.
· Chapter 2 - Overview of RJS Electronic Forms: describes RJS Electronic Forms
software suite, the benefits of using Electronic Forms and licensing of the product.
· Chapter 3 - Installation: provides step-by-step instructions to install and configure all
software associated with RJS Electronic Forms on your iSeries.
· Chapter 4 - Getting Started: provides a quick start to using RJS Electronic Forms
software suite. Detailed instructions are found later in this manual.
· Chapter 5 - WinSpool/400 Report Download: provides detailed instructions on using
WinSpool/400 Report Download software.
· Chapter 6 - Text Layer Designer: Provides detailed instructions on using RJS Text Layer
Designer to map spool file data to FormDocs templates.
· Chapter 7 - WinSpool/400 Print Server: provides detailed instructions on using the
WinSpool/400 Print Server to automate your electronic forms environment.
· Chapter 8 - FAQs: includes frequently asked questions regarding RJS Electronic Forms.
· Chapter 9 - Understanding WinSpool/400 Data Areas: describes all OS/400 data areas
found in the WinSpool/400 library.
About RJS Software Systems
RJS Software Systems is a privately-held software and hardware company dedicated to
providing high-quality i5/iSeries, Client/Server and web-based products and customer services.
Customer Service is central to the company's objective. Read more about us on our web site,
RJS web site.
Copyright
© 1995-2005 RJS Software Systems All rights reserved. This manual and the software described
in it are copyrighted with all rights reserved. No part of this publication may be reproduced,
transmitted, transcribed, stored in a retrieval system or translated into any language in any form
by any means without the written permission of RJS Software Systems.
Trademarks
RJS Text Layer Designer ™ is a trademark of RJS Software Systems. Brand names and
product names are trademarks or registered trademarks of their respective companies.
What's Not in This Book
This reference manual does not describe the following:
· Configuration and use of individual document input equipment (i.e. fax or scanner). Refer to
manufacturer instructions for help.
· Detailed explanation on the use of FormDocs software. You can find extensive help with this
package by accessing the on-line help feature of FormDocs.
· Explanation or help with OS/400 commands, outside the scope of need as it pertains to
Electronic Forms creation and printing.
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Document Conventions and Symbols
The following document conventions are used throughout this reference manual:
· Acceptable hardware server for WinSpool/400 could be noted as AS/400, iSeries, or i5. For
simplicity, all references to the server in this manual will default to the term iSeries unless the
notation is specific to a specific server model.
· With V5R3 of the iSeries operating system, IBM has renamed the operating system to i5/OS.
The operating system was formerly known as OS/400. For simplicity, all references to the
operating system in this manual will default to OS/400 unless the notation is specific to the new
i5/OS.
· Titles of documents appear in Italics. Italic type is also used to indicate information that varies
by circumstance.
Contacting RJS Software Systems
For technical support, please review the following information before contacting RJS Software
Systems.
For Technical Support with RJS Text Layer Designer
Because of the complexity of dealing with the various AS/400 connectivity environments, please
gather and organize as much information as possible on the problem prior to contacting RJS
Software Systems for support.
If you have a question about a RJS Text Layer Designer operation, first browse through the
Online Help to try to find your answer prior to calling RJS Software Systems.
Contact Information
Telephone support is available on normal business days from 8:00 am to 5:00 pm central time.
(952) 898-3038 Voice
(952) 898-1781 Fax
Support is available via Email at [email protected].
You may also find the answer to your question on our web site: www.rjssoftware.com.
© 1995-2005 RJS Software Systems
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Overview of RJS Electronic Forms
The RJS Electronic Forms software consists of several applications that allow you to download
iSeries spool file data, convert it to ASCII text and then merge the spool file data with an
electronic form in preparation of printing the forms.
Introduction to RJS Electronic Forms
The automation of creating and printing electronic forms appears complex, but in reality is quite
simple due to the tight integration of RJS software products.
There are several products involved in the automation of electronic forms: WinSpool/400,
FormDocs, Text Layer Designer and Electronic Form Print Server. WinSpool/400 monitors
iSeries output queues for appropriate spool files, converts these files to usable text format and
downloads the text files to PCs. FormDocs is used to define the layout and calculations
associated with each electronic form. Text Layer Designer is used to diagram the fields of data
available in converted spool files to the fields defined in the electronic forms. And finally, the
Electronic Form Print Server is used to print batches of forms at any given time.
Below you can see a simplified picture of the process to turn spool file data into printed forms,
such as Accounts Receivable invoices. The process begins with spool files that are stored in
output queues on iSeries systems. Spool files are created by many iSeries applications; for
example, you may have spool files that were created from applications such as A/R, P/R, Project
Management, Patient Management or Insurance Claims Management. In years past, these
reports/forms would have been printed on pre-printed forms using high-end printers attached to
the iSeries. In this age of corporate cost-savings, the elimination of pre-printed forms can create
noticeable cost savings within a corporation. Forms created with FormDocs allow corporations to
print forms on standard paper using a printer attached to a PC. Through WinSpool/400 and Text
Layer Designer RJS has provided a cost-effective method of merging iSeries application data
and aid in creating reports/forms that can be printed on plain paper. Actual printing of the reports
is accomplished as a batch process using Electronic Form Print Server.
© 1995-2005 RJS Software Systems
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Electronic Forms Process using Text Layer Designer
Licensing Information
RJS Electronic Forms licensing is based iSeries server(s), design station(s) and Electronic Forms
Print Server stations;
iSeries Server: Licensing is on a per server or per iSeries LPAR (partition).
Design Station: Design station(s) are used to create and modify electronic forms using
FormDocs, Text Layer Designer and WinSpool/400 Report Download. Standard licensing
includes one PC, separate from print server station, that can be used to design electronic
forms.
Electronic Forms Print Server: Print server station(s) are used to automate the
downloading, merging and printing of electronic forms. Standard licensing includes one PC
to be used as a print server. This PC will have Electronic Forms Print Server, FormDocs
and Text Layer Designer software installed.
© 1995-2005 RJS Software Systems
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Installation
Introduction to Installation
This section covers the installation of the Electronic Forms software group. Portions of the
software will be installed on the iSeries system and portions will be installed on PC(s). It is
important for any individual that intends to install any/all Electronic Forms software product(s) to
read this section prior to the installation process.
The basic steps to installing Electronic Forms software group consists of the following:
1. Review system requirements.
2. Download and install RJS Software Download Utility, if necessary.
3. Design Station(s): using RJS Software Download Utility, install Visual Basic 5.0 runtime
files, WinSpool/400 Report Download and Text Layer Designer components.
4. Electronic Forms Print Server Station(s): using RJS Software Download Utility, install
WinSpool/400 Electronic Forms, WinSpool Report Download, WinSpool/400 OS/400 library,
Text Layer Designer and FormDocs components.
System Requirements
RJS Electronic Forms is a flexible product with minimum system requirements. However, you
should still review the listed requirements for your iSeries system and any PCs that will create
and print electronic forms.
iSeries
Following are the WinSpool/400 requirements for iSeries systems:
· RISC iSeries or i5 system running V4R3-V5R3 or above.
· TCP/IP connectivity must be enabled.
· No special PTFs are required for WinSpool/400, however it is always a good idea to be
current on iSeries system PTFs.
PCs used to Create/Print Electronic Forms
You can have unlimited number of PCs that are used for creating and testing Electronic Form
templates. Each PC that is used for the WinSpool Electronic Forms Print Server must be
licensed to use the product. The PC requirements are the same for both environments. Each
PC that will be used to create/test electronic forms or act as a print server must have the
following installed and running:
· Windows PC running Windows 95, 98, ME, NT, 2000 or XP, preferably Pentium 800 mhz or
above.
· 256 Mb memory; running with less memory is possible but expect poor performance.
· 1-2 Gb free disk space.
· TCP/IP must be running on the PC.
· VB 5.0 runtime files installed.
· Forms Creation: FormDocs software, Text Layer Designer (also known as Form Merge
engine) and WinSpool/400 Report Download software.
· Print spooler: WinSpool/400 Electronic Forms Print Server software and WinSpool/400
Report Download software, Text Layer Designer software and FormDocs software.
Refer to the individual installation sections later in this chapter for installation instructions for
each of the specified applications/utilities.
© 1995-2005 RJS Software Systems
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NOTE: Client Access/400 is not required.
RJS Software Download Utility
To simplify the installation process of RJS Software Systems software packages RJS now has a
download utility program. The RJS Software Download Utility allows you to install individual
software components, software product(s), which may or may not include multiple components or
any combination of products and components. Installation includes the ability to first download
the most recent version of the selected products and components from the RJS Software
Systems website. This new utility both clarifies required components of any given product and
eliminates the need for our customers to individually download and install each of those
components.
You must have the RJS Download Utility to install any RJS Software Systems products. If you
have not already downloaded the RJS Software Download Utility, follow the steps below to
download and install the utility.
Install RJS Software Download Utility
1. Using an internet browser, access the RJS Software Systems web site:
www.rjssoftware.com
2. Select Downloads from the website menu bar.
You will be presented with a screen that looks similar to the one below:
Main RJS Software Systems Download Web Page
3. Click to download the utility.
You will receive a message similar to the following:
© 1995-2005 RJS Software Systems
13
RJS Electronic Forms
Standard Security Warning for Downloads
4. Click Run to execute the RJS Software Download Utility installation program.
You will receive a confirmation message to install the utility.
Installation Confirmation Message
5. Click OK to continue the installation.
You will be prompted to select a destination directory:
Select Destination Directory
6. Either click OK to accept the default installation directory or choose the desired destination
directory.
You will be prompted to add icons to Program Manager.
© 1995-2005 RJS Software Systems
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Prompt to Install Icons
7. Click Yes to add icons to Program Manager.
You will be prompted to select a Program Group for the icons.
Select Program Group
8. Either click OK to accept the default Program Group or select or type a Program Group.
You will receive a message stating necessary Window's DLL files were registered
successfully.
DLL Registration Message
9. Click OK to continue the utility installation.
You will receive an installation success message.
Installation Complete Message
The RJS Software Download Utility is now installed and ready to use to install any RJS Software
Systems products. Refer to the next section WinSpool/400 Electronic Forms for details on
installing the WinSpool/400 Electronic Forms components.
© 1995-2005 RJS Software Systems
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WinSpool/400 Electronic Forms
When you select to install WinSpool/400 Electronic Forms you will be presented with the option
to install several components. You may choose to install all or some combination of components
on each PC. The components you choose to install should be based on desired functionality for
the particular PC you are installing software to. For example, PCs that will be used as your
electronic forms print server should have all components installed to them. Refer to the System
Requirements section for details of required components.
It is important to note that the OS/400 library only needs to be installed once on any given
iSeries system. This component can be installed independently of any other components or
during one of your installations for design or print server stations.
Each WinSpool/400 Electronic Forms component is described below:
Visual Basic 5.0 Runtime Files
The RJS Electronic Forms group of software requires Visual Basic 5.0 Runtime files to be
installed on any PC that will be used either create or process electronic forms.
WinSpool/400 Report Download Utility
The WinSpool/400 Report Download utility provides the capability to download spool files
and then convert those files into text files with an acceptable format that can be used by both
FormDocs and Text Layer Designer. The WinSpool/400 Report Download utility should be
installed on any PC that will be used to define electronic forms and on the PC that will be
used as the Electronic Forms Print Server.
WinSpool/400 Report Download Update
Recently RJS made a software update available for WinSpool/400 Report Download Utility.
If you are installing WinSpool/400 Report Download you should also select to download the
utility update.
WinSpool/400 OS/400 Library
All RJS software products are now installed directly from our website. This ensures that
when you install a product from RJS it is the most current version available.
WinSpool/400 Electronic Forms
The WinSpool/400 Electronic Forms utility includes both a print server to automate your
forms printing process and a utility (Text Layer Designer) that merges spool file data fields
with pre-defined forms created in FormDocs software. This section guides you through the
process of installing and updating the base WinSpool/400 Electronic Forms software which
includes the print server portion of electronic forms. The next section in this manual will
install the Text Layer Designer utility. The WinSpool/400 Electronic Forms utility should be
installed on any PC that will be used to define electronic forms and on the PC that will be
used as the Electronic Forms Print Server.
WinSpool/400 Electronic Forms Update
Recently RJS made a software update available for WinSpool/400 Electronic Forms. If you
are installing WinSpool/400 Electronic Forms you should also select to download the update.
Text Layer Designer
RJS Text Layer Designer is used to map spool file data to pre-defined fields within a
FormDocs form. The FormDocs form is used to specify where data fields, generic text and
graphic images should be printed for each form within your business. In most cases, the
layout of the form and the data fields do not match the layout of your iSeries spool files.
Text Layer Designer gives you the ability to diagram the spool file data in conjunction with
the pre-defined form data fields.
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FormDocs
FormDocs software is used to define the layout of forms such as invoices, purchase orders,
or packing slips and then create digital version of the forms complete with data that can then
be printed using a standard PC printer. Forms are defined using Form Designer. Forms are
comprised of graphic objects such as lines and rectangles, generic text like your company
name and address, graphic images such as company or product logos and data fields. Form
Filler completes the forms by inputting data into the forms. FormDocs should be installed
on any PC that will be used to create or test electronic forms.
The Software Download Utility provides you with the functionality to both download the software
to be installed and to initiate the installation process of one or more software components. The
simplest and quickest download/installation process can be achieved by ensuring the option Run
Files When Download is Complete is enabled when you choose to install software. By enabling
this option, the Software Download Utility will first download the selected software components
and then initiate the installation of each component. If you choose not to enable this option, you
will need to individually install each component.
Download Necessary Components
The following instructions have been written assuming that you will choose to enable Run Files
When Download is Complete. In addition, since it is difficult to guarantee which components are
selected for installation, the instructions will describe how to select components, download the
software and begin the automatic initiation of selected components. The installation prompts and
help for each component can be found in individual sections of this manual. Refer to appropriate
sections as you progress through each component installation.
Download WinSpool/400 Electronic Forms Components
1. Open RJS Software Download Utility from the RJS Software Downloader group.
You will be presented with the main Software Download Utility screen, shown below:
RJS Software Download Utility Main Screen
2. Select either the WinSpool/400 Electronic Forms product or the desired WinSpool/400
Electronic Forms individual components from the product list.
© 1995-2005 RJS Software Systems
17
RJS Electronic Forms
For this example, the overall product option was selected and then the individual component
list expanded. Your screen will look similar to the one shown below:
RJS Software Download Utility - WinSpool/400 Electronic Forms Components Selected
3. Ensure Run Files When Download is Complete option is enabled.
4. Click Download to initiate the component download process.
If this is the first product you have downloaded since opening RJS Software Download Utility
will you will be prompted to enter a valid User ID and Password. Contact RJS Software
Systems Support staff if you do not have a User ID and Password. The Login dialog is
presented:
RJS Software Download Login
5. Enter a valid User ID and Password, as given by RJS Software Systems.
RJS Software Download Utility will proceed to download all selected WinSpool/400 Electronic
Forms components. Refer to the following individual component installation notes for help as the
components are installed.
Installing Visual Basic 5.0 Runtime Files
When using the RJS Software Download Utility to install Visual Basic Runtime files use the
following steps to guide you through the process.
1. You will be presented with the WinZip Self-Extractor message.
© 1995-2005 RJS Software Systems
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WinZip Self-Extractor Dialog Box
2. Click the Setup button to extract installation files/programs.
You will be presented with the Welcome dialog for installing Visual Basic 5.0 files.
Visual Basic Initial Installation Screen
3. Click Next to proceed with the installation.
You will be presented with confirmation screen to install the selected files.
Visual Basic Installation Confirmation
4. Click Next to install the Visual Basic runtime files.
You will be presented with installation success message:
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Visual Basic Installation Complete Message
5. Click Finish to complete the installation.
If you are using the RJS Software Download Utility to install this component, the download utility
will now continue to the next selected component.
Installing WinSpool/400 Report Download Utility
When using the RJS Software Download Utility to install WinSpool/400 Report Download Utility
files use the following steps to guide you through the process.
1. You will be presented with the WinZip Self-Extractor message.
WinZip Self-Extractor Dialog Box
2. Click the Setup button to extract installation files/programs.
You will be presented with a Welcome message:
WinSpool/400 Report Download Installation Welcome Message
3. Click OK to continue setup of WinSpool/400 Report Download.
You will be reminded that the Visual Basic 5.0 Runtime files must be installed prior to
WinSpool/400 Report Download Utility. If you are following the automatic product
download/installation process the Visual Basic Runtime files installation should have
completed just prior to installing this component. The message is as shown:
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4. Click OK to continue the installation process.
You will be prompted to select the components to install:
WinSpool/400 Report Download Utility Component Selection
5. Ensure WinSpool/400 Program Files option is enabled.
6. Ensure AS/400 Library Installation Files option is enabled.
7. Click OK to continue the installation process.
You will be prompted to select destination directory to install software into.
Destination Directory
8. Click OK to continue the installation process.
Once installation of PC component is complete you will be prompted to create program
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icons.
Install Icons Prompt
9. Click Yes to create program icons (shortcuts to call the programs).
You will be prompted for the destination directory for OS/400 library to be copied to.
Select OS/400 Library Destination Path
10. Choose either the Default directory or select the desired directory path to install OS/400
library files to.
You will be reminded to run the FTP-based library application to physically install these
programs on the iSeries. See the following section for help installing the OS/400 library.
OS/400 Library Installation Reminder Message
11. Click OK to continue the installation process.
You will be presented with a success message:
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WinSpool/400 Report Download Installation Success Message
12. Click OK to complete the installation process.
If you are using the RJS Software Download Utility to install this component, the download utility
will now continue to the next selected component.
Installing WinSpool/400 Report Download Update
Recently an update to the WinSpool/400 Report Download software was placed on the website.
When using the RJS Software Download Utility to install WinSpool/400 Electronic Forms Update
files use the following steps to guide you through the process.
1. You will be presented with the WinZip Self-Extractor message. Select the directory where
WinSpool/400 Report Download was installed to unzip program files to by clicking on the
Browse button or typing the directory path.
WinZip Self-Extractor Dialog Box
2. Click the Unzip button to extract update files.
One file will be extracted into the WinSpool/400 Report Download directory. The update is
complete. A success message will be displayed.
WinZip Extractor Success Message
3. Click the OK button to close the WinZip Self-Extractor dialog box.
If you are using the RJS Software Download Utility to install this component, the download utility
will now continue to the next selected component.
Installing WinSpool/400 OS/400 Library
When using the RJS Software Download Utility to install WinSpool/400 OS/400 library files use
the following steps to guide you through the process.
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Note: if you are using other WinSpool/400 products do not install the WinSpool/400 library.
Doing so will clear out all of your other WinSpool/400 product access codes. If you would like to
update your Winspool/400 library, contact RJS Software Systems for detailed instructions on the
WinSpool/400 upgrade process.
1. You will be presented with the WinZip Self-Extractor message.
Select the temporary directory to unzip program files to by clicking on the Browse button or
typing a directory path.
WinZip Self-Extractor Dialog Box
2. Click the Unzip button to extract installation files/programs.
3. Once the files have been extracted you will receive a message box noting the success.
WinZip Success Message
4. Click OK.
5. You will be presented with the RJS FTP Install message.
FTP Install Message
6. Click OK.
7. The RJS FTP Library Install program starts.
You will be presented with the main dialog box. Refer to this image as you complete the
remaining steps.
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FTP Library Installation Screen
8. Enter the selected iSeries IP address or DNS name in the AS/400 Host IP Address edit box.
9. Enter a valid iSeries security officer user ID and password in the appropriate edit boxes.
10. Select the appropriate hard-drive designator for your PC.
11. Select Step 1 to Connect to the AS/400 FTP server.
Watch for success/failure messages in the Progress Messages area of the dialog box.
12. Select Step 2 to create the Temporary AS/400 Installation Library (PCSINST).
Watch for success/failure messages in the Progress Messages area of the dialog box.
13. Select Step 3 to Upload the AS/400 library file from the PC.
Watch for success/failure messages in the Progress Messages area of the dialog box.
14. Select Step 4 to Clear the library if it already exists and then restore the library to the
iSeries system.
Watch for success/failure messages in the Progress Messages area of the dialog box.
15. Select Step 5 to Delete the Temporary AS/400 Installation Library (PCSINST).
Watch for success/failure messages in the Progress Messages area of the dialog box.
16. Select Step 6 to Disconnect from the AS/400 FTP Server.
Watch for success/failure messages in the Progress Messages area of the dialog box.
17. Select Step 7 to Exit the FTP Library Installation program.
18. Delete the temporary PC directory C:\PCSINST (default location).
If you are using the RJS Software Download Utility to install this component, the download utility
will now continue to the next selected component.
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Installing WinsSpool/400 Electronic Forms Utility
When using the RJS Software Download Utility to install WinSpool/400 Electronic Forms Utility
files use the following steps to guide you through the process.
1. You will be presented with the WinZip Self-Extractor message.
WinZip Self-Extractor Dialog Box
2. Click Setup to continue setup of WinSpool/400 Report Download.
You will be prompted to confirm installation of the product.
Components to Install
3. Click OK to continue the installation.
You will be prompted to select a destination directory:
Select Destination Directory
4. Either click OK to accept the default installation directory or choose the desired destination
directory.
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You will be prompted to add icons to Program Manager.
Prompt to Install Icons
5. Click Yes to add icons to Program Manager.
You will receive a message stating necessary Window's DLL files were registered
successfully.
DLL Registration Message
6. Click OK to continue the installation.
You will receive an installation success message.
Installation Complete Message
If you are using the RJS Software Download Utility to install this component, the download utility
will now continue to the next selected component.
Installing WinSpool/400 Electronic Forms Update
Recently an update to the WinSpool/400 Electronic Forms software was placed on the website.
When using the RJS Software Download Utility to install WinSpool/400 Electronic Forms Update
files use the following steps to guide you through the process.
1. You will be presented with the WinZip Self-Extractor message. Select the directory where
WinSpool/400 Electronic Forms was installed to unzip program files to by clicking on the
Browse button or typing the directory path.
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WinZip Self-Extractor Dialog Box
2. Click the Unzip button to extract update files.
One file will be extracted into the WinSpool/400 Electronic Forms directory. The update is
complete. A success message will be displayed.
WinZip Extractor Success Message
3. Click the OK button to close the WinZip Self-Extractor dialog box.
If you are using the RJS Software Download Utility to install this component, the download utility
will now continue to the next selected component.
Installing Text Layer Designer Utility
When using the RJS Software Download Utility to install Visual Basic Runtime files use the
following steps to guide you through the process.
1. You will be presented with the WinZip Self-Extractor message. Select the Setup to install
the utility.
WinZip Self-Extractor Dialog Box
2. Click OK to begin installation process.
You will be presented with a Welcome message.
Text Layer Designer (Electronic Forms Engine) Welcome Message
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3. Click Next to continue the installation process.
You will be prompted to choose type of electronic forms usage.
Text Layer Designer Usage Prompt
4. Select WinSpool/400 Electronic Forms.
The only exception to this is if you are a long-time RJS eForms customer that is using the
Reform product. If that is the case, choose RJS eForms.
5. Click Next to continue the installation process.
You will be prompted for the installation destination directory.
Destination Directory
6. Click Next to continue the installation process.
You will be prompted to start the install process.
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Start Installation Prompt
7. Click Next to install the product.
You will be presented with a installation success message.
Installation Success Message
8. Click Finish to complete the installation process.
After copying files, the Setup program will update the WinSpool Electronic Forms group with a
short-cut for Text Layer Designer and notify you when it's done.
If you are using the RJS Software Download Utility to install this component, the download utility
will now continue to the next selected component.
Installing FormDocs Software
When using the RJS Software Download Utility to install Visual Basic Runtime files use the
following steps to guide you through the process.
1. You will be presented with the WinZip Self-Extractor message. Select Setup to install the
utility.
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2. Click Setup to begin the installation process.
You will be presented with a Welcome message.
FormDocs Welcome Message
3. Click Next to continue the installation process.
You will prompted to accept the FormDocs licensing agreement.
FormDocs License Agreement
4. Click Yes to accept the agreement.
You will prompted for FormDocs license details.
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FormDocs Registration Details
5. If you have a permanent license key, enter the license details into the Registration dialog.
If you are evaluating the product enter DEMO into the Registration code field.
You will prompted for an installation directory destination.
FormDocs Installation Directory Destination
6. Click Next to continue the installation process.
You will be prompted to begin the actual installation.
Begin Setup Prompt
7. Click Next to install the product.
You will be presented with an installation success message.
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FormDocs Installation Success Message
8. Select either Start Filler or Start Designer to view the product.
After copying files, the Setup program will create the program group FormDocs with short-cuts
for both Form Designer and Form Filler and notify you when it's done.
If you are using the RJS Software Download Utility to install this component, the download utility
will now continue to the next selected component.
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Getting Started
The purpose of this section is to describe how to quickly get started using the RJS WinSpool/400
software suite to develop a new form in FormDocs then using Text Layer Designer to map spool
file data to the fields in the new form. To get the most out of the Getting Started section you
should progress through the sections sequentially.
Sample Report Merge
When you installed WinSpool/400 Electronic Forms a sample invoice template (invoice.FDT),
Text Layer mapping (invoice.FDT) and converted spool file invoice data (invoice.TXT) were
installed in the WinSpool/400 directory. We will use these sample files to show you how quickly
you can merge data with the form template, even when the order and placement of the data does
not match the form template.
Merge Data with Invoice Form
1. Open RJS Text Layer Designer from the WinSpool Electronic Forms program group.
You will be presented with an empty Text Layer Designer screen.
2. From the File menu, select Open Form Template Field List.
Each form template created in FormDocs contains a list of fields (data points) used in the
form. Text Layer Designer maps the spool file text data to one or more of the fields
described in the form template.
3. By default Text Layer Designer will display files found in the \Program
Files\FormDocs\Templates directory which is where the sample files are located. Open the
file invoice.fdt.
You will briefly see the flash screen for FormDocs Filler tool and then your screen will return
to the empty Text Layer Designer screen. Although it appears that nothing has happened,
Text Layer designer has loaded the field information into memory.
4. Click on the Check for Unmatched Form Fields button from the tool bar.
Check for Unmatched Form Fields button
You will be presented with a list of all fields that are currently missing text layer mapping.
Since we have not yet opened our Text Layer Designer mapping for the invoice form all
fields will be noted in the dialog box. The dialog box should look similar to the one below:
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Text Layer Designer Unmatched Field Check
5. Click OK to close the dialog box.
6. From the File menu, select Open Report Text Layer.
Text Layer Designer automatically opens the associated file for our invoice template. Text
Layer Designer looks for a ".TLR" file with the same name as the form template opened in
the first step. In this case the file opened was invoice.tlr. To aid in the readability and
interpretation of the text layer report you will see the following message:
Text Layer Designer Message
7. Click Yes to open the associated converted spool file.
8. Open the text file invoice.txt.
Your screen should now look similar to the one shown below:
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Text Layer Designer Showing Completed Text Layer Report
9. Click on the green rectangle surrounding the customer name on the left side of the invoice.
There will be sizing handles around the perimeter of the box and details of the field mapping
description is shown in the status line at the bottom of the screen. In this example we see
that the Customer name and address information has been mapped to the field BillTo. You
will also see the exact placement of the mapping object. Your screen will look similar to the
one shown below - notice the status line details:
© 1995-2005 RJS Software Systems
37
RJS Electronic Forms
Text Layer Designer - Sample Field Definition Details
10. To test the actual merge of spool file data with the FormDocs template, select Test Merge
from the File menu.
You will be asked if you want to save the text layer report.
11. Since we have not made any changes to the text layer report, click No.
You should receive a success message from Text Layer Designer.
Successful Text Merge Message
12. Click OK.
A sample PDF of the merged invoices will be opened.
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Sample Invoice PDF
13. Scroll through the pdf file to view all invoices created.
Create A Form
Creation of a form is done by using the FormDocs software. In essence you are creating a
template for each of the electronic forms you will be printing from your PC. Common uses of
electronic forms include employee applications, time sheets, expense reports, invoices, sales
quotes, etc.
Your form template is comprised of data fields, standard text, graphic objects such as lines and
rectangles and graphic images such as your company logo. This section will step you through
the creation of a sales invoice. The invoice form will be used in the later sections of Getting
Started sections of this manual to map spool file data and then test the merge of form and data.
Below is a sample of the invoice you will create in this section:
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Sample Invoice created with FormDocs
Note: This section is meant to offer a quick-start tutorial for creating a template in FormDocs. It
is not meant to document all features of the product. The on-line FormDocs help can provide
you with detailed help of all features of the product.
Useful Product Notes
· Every object has a type - line, arrow, ellipse, rectangle, text, field, table, picture, check box,
option button or command button.
· Use the drawing toolbar on the left to select desired object type. Below is a sample of the
drawing toolbar.
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Drawing Toolbar
· Every object has an exact placement and size on the template. Precision x/y coordinates and
height and width can be controlled by using the positioning toolbar. Below is a sample of the
positioning toolbar.
Positioning Toolbar
· The look and feel of all objects is controlled through the Appearance option found both on the
Format menu and by right-clicking when an object is selected.
· To define details such as field name, type, or calculations of Field objects select the Properties
option from the Format menu or by right-clicking when a field object is selected.
· Although field objects can have borders, shading and some control on the look and feel, RJS
recommends you create graphic objects such as lines and rectangles to create the form
background and then place field objects within and on top of the graphic objects. This will give
you more control on formatting and placement.
Create FormDocs Invoice Form
1. Open FormDocs software from the FormDocs program group.
By default, FormDocs presents you with the FormDocs Assistant. The dialog will look similar
to the following:
FormDocs Assistant
2.
Select Create a new template and click OK.
You will be presented with a blank template. By default, FormDocs will show a light grey grid
to aid in aligning objects on the template. If your grid is not showing, select Grid from the
View menu.
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3. Before you begin creating objects, ensure the Snap to Grid option is disabled. The Snap to
Grid option toggles on and off from the Arrange menu.
4. We will start by creating the area of the invoice that will contain invoice information. Click on
the Draw Rectangle button on the Drawing toolbar.
5. From the Format menu, select Appearance.
The Appearance dialog allows you to predefine the rectangle object properties. The dialog
will look like the following:
FormDocs Appearance Dialog - Border Tab
6.
Enable the option Rounded - a check-mark will be displayed in the option box.
7. Enter 0.30 in the adjustment box to the right of the Rounded option.
8. Click on the Background tab.
The Background tab will look like the following:
FormDocs Appearance Dialog - Background Tab
9. Select 25% Grey from the Color drop-down list.
10. Click OK.
The cursor will change to a crosshair. This indicates you will be drawing an object when you
click and drag the mouse.
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11. Position the cursor just to the right of center and approximately 3/4" from the top - do not be
to concerned with exact positioning and size as we will use the positioning toolbar to adjust
placement and size - click and drag the mouse so that you have a rectangle that is
approximately 3.5" wide and 0.5" high.
When you release the mouse the grey-filled rectangle will appear on the form. Your form
should look similar to the one shown below:
New Rounded-Rectangle Object
12. Use the Positioning Toolbar to enter the following coordinates:
x: 4.3438
y: 0.7813
w: 3.5938
h: 0.2813
Your template should now look similar to the one shown below:
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Final Rounded-Rectangle Shape
13. Create the remaining four rounded-rectangles on your own. Below are the positioning
coordinates you should use for each:
Object 1 -
x: 0.4375
y: 2.0625
w: 3.5625
h: 0.2813
Object 2 -
x: 4.3125
y: 2.0625
w: 3.6250
h: 0.2813
Object 3 -
x: 0.4375
y: 3.6875
w: 7.5000
h: 0.2813
Object 4 -
x: 0.4375
y: 4.3438
w: 7.5000
h: 0.9063
After completing the above objects, your template should look similar to the one below:
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14. Again, click on the Draw Rectangle icon on the Drawing toolbar.
15. From the Format menu, select Appearance.
16. Disable the Rounded option and change the background color to White.
17. Now, create all basic rectangles on the form on your own. Below are the positioning
coordinates you should use for each:
Object 1 -
x: 4.3438
y: 0.9375
w: 3.5938
h: 0.9775
Object 2 -
x: 0.4375
y: 2.2188
w: 3.5625
h: 1.3125
Object 3 -
x: 4.3125
y: 2.2188
w: 3.6250
h: 1.3125
Object 4 -
x: 0.4375
y: 3.8438
w: 1.1875
h: 0.3750
Object 5 -
x: 1.6250
y: 3.8438
w: 1.7500
h: 0.3750
Object 6 -
x: 3.3750
y: 3.8438
w: 1.9688
h: 0.3750
Object 7 -
x: 5.3438
y: 3.8438
w: 1.4688
h: 0.3750
Object 8 -
x: 6.8125
y: 3.8438
w: 1.1250
h: 03750
Object 9 -
x: 0.4375
y: 4.7813
w: 1.1250
h: 4.3125
Object 10 -
x: 1.5625
y: 4.7813
w: 1.1563
h: 4.3125
Object 11 -
x: 2.7188
y: 4.7813
w: 2.0313
h: 4.3125
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Object 12 -
x: 4.7500
y: 4.7813
w: 1.5000
h: 4.3125
Object 13 -
x: 6.2500
y: 4.7813
w: 0.6250
h: 4.3125
Object 14 -
x: 6.8750
y: 4.7813
w: 1.0625
h: 4.3125
Object 15 -
x: 0.4375
y: 9.0938
w: 4.5625
h: 1.4063
Object 16 -
x: 5.000
y: 9.0938
w: 2.0313
h: 1.4063
Object 17 -
x: 7.0313
y: 9.0938
w: 0.9063
h: 1.4063
After completing the above objects, your template should look similar to the one below:
Template with Additional Rectangles
18. Click on the Draw Line icon on the Drawing toolbar.
19. You are going to draw a vertical line that will be used to section off the top columnar section.
Position the cursor at the top of the grey section which will be approximately 3 3/4" down the
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page (use the rulers) and approximately 1 1/2" from the left-hand side of the page - do not be
to concerned with exact positioning and size as we will use the positioning toolbar to adjust
placement and size - click and drag the mouse so that you have a vertical line that is
approximately 1/4" high.
When you release the mouse the line will appear on the form.
Hint: If you are having difficulty drawing a straight line, hold down the shift key while
drawing the line. Holding the shift key restricts your line to be drawn vertically, horizontally
or at a 45 degree angle.
20. Adjust the Positioning coordinates to match the following:
x: 1.6250
y: 3.6875
w: 0.0035
h: 0.1875
Your screen should look similar to the one shown below - the new line is noted:
Template with New Vertical Line Drawn
21. Create the remaining eight lines using the following positioning coordinates:
Note: If you want, try using the duplicate object feature to create most of these lines and
then just adjust the coordinates. Select the line created above and create three duplicate
line objects that are offset to the right a small distance. Refer to the help text for help on
using the feature. Once those are completed, manually draw line number 5 then, again,
duplicate the lines and adjust.
Line 2 -
x: 3.3750
y: 3.6875
w: 0.0035
h: 0.1875
Line 3 -
x: 5.3438
y: 3.6875
w: 0.0035
h: 0.1875
Line 4 -
x: 6.8125
y: 3.6875
w: 0.0035
h: 0.1875
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Line 5 -
x: 1.5625
y: 4.3438
w: 0.0035
h: 0.4375
Line 6 -
x: 2.7188
y: 4.3438
w: 0.0035
h: 0.4375
Line 7 -
x: 4.7500
y: 4.3438
w: 0.0035
h: 0.4375
Line 8 -
x: 6.2500
y: 4.3438
w: 0.0035
h: 0.4375
Line 9 -
x: 6.8750
y: 4.3438
w: 0.0035
h: 0.4375
Your template should look similar to the one shown below:
Line Objects on Invoice Template
22. Click on the Draw Text icon on the Drawing toolbar.
23. Click on the upper right-hand corner of the invoice.
A text object will be created with the word label within it.
24. Highlight the word label and then type Invoice.
25. Highlight Invoice and change the font to Arial 20 using the icons on the Formatting toolbar.
26. Use the Positioning Toolbar to enter the following coordinates:
x: 6.9688
y: 0.4688
w: 1.1875
h: 0.3438
Your template should now look similar to the one shown below:
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"Invoice" Text Object
27. Now, create remaining text objects on the form on your own. Below is the text, font details
and positioning coordinates you should use for each:
Invoice Information
Arial 10
x: 5.6250
y: 0.7813
w: 1.3125
h: 0.1875
Invoice No:
Arial 11
x: 5.2500
y: 1.1563
w: 0.8125
h: 0.1875
Invoice Date:
Arial 11
x: 5.1250
y: 1.4063
w: 0.9063
h: 0.1875
Order No:
Arial 11
x: 5.3438
y: 1.6563
w: 0.7188
h: 0.1875
Bill To
Arial 10
x: 1.9688
y: 2.0625
w: 1.0625
h: 0.1875
Ship To
Arial 10
x: 5.8750
y: 2.0625
w: 1.0625
h: 0.1875
Ship Date
Arial 10
x: 0.5938
y: 3.6875
w: 0.7813
h: 0.1875
Terms
Arial 10
x: 2.2188
y: 3.6875
w: 0.7813
h: 0.1875
Ship Via
Arial 10
x: 4.1563
y: 3.6875
w: 0.7813
h: 0.1875
Sales Person
Arial 10
x: 5.6875
y: 3.6875
w: 1.0625
h: 0.1875
Due Date
Arial 10
x: 7.0625
y: 3.6875
w: 1.0625
h: 0.1875
Qty. Ordered
Qty. BackOrd
Arial 10
x: 0.6563
y: 4.4063
w: 0.8750
h: 0.3438
Qty. Shipped
Arial 10
x: 1.7188
y: 4.4063
w: 0.8750
h: 0.1875
Item Number
Arial 10
x: 2.7813
y: 4.3750
w: 0.8750
h: 0.3750
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Description
Unit Price
Arial 10
x: 5.5938
y: 4.3750
w: 0.8750
h: 0.1875
Tax
Arial 10
x: 6.4375
y: 4.3750
w: 0.3750
h: 0.1875
Ext Price
Arial 10
x: 7.2500
y: 4.3750
w: 0.7813
h: 0.1875
Subtotal
Arial 11
x: 6.4375
y: 9.2500
w: 0.8125
h: 0.1875
Sales Tax
Arial 11
x: 6.3125
y: 9.5313
w: 0.8750
h: 0.1875
Freight
Arial 11
x: 6.5313
y: 9.8125
w: 0.7188
h: 0.1875
Invoice Total
Arial 12 Bold x: 5.9688
y: 10.2188
w: 1.0625
h: 0.1875
28. Create one last text object with Arial 10 with Centered Text alignment. Use the following
positional coordinates:
x: 1.2813
y: 9.3750
w: 2.9688
h: 0.8438
29. Insert the following lines of text into the text object - note text will be centered on the
template:
All Currency is in U.S. Dollars
Notice On all Past Due Accounts 1.5%
Interest Charge Added Per Month
Minimum charge $10.00
Template should now look similar to the following:
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Invoice with Background Text Objects
30. Click on the Draw Field icon on the Drawing toolbar.
31. Position to the cursor to the right of the text "Invoice No:" then click and drag to create a
rectangle approximately 1.75" wide by 0.25" high.
When you release the cursor, a rectangle will denote the new field.
32. From the Format menu, select Properties.
33. Type InvoiceNo in the Field edit box.
Since all of our data will be coming from a converted spool file data, all fill data will be type
text. There is no need to define any additional field properties. The completed Properties
dialog will look like the following:
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Properties dialog Box - General Tab
34. Click OK.
35. From the Format menu, select Appearance.
36. Select No Line from the Color drop-down list.
The Border tab should look like the following:
Appearance Dialog - Border Tab
37. Click on the Background tab.
38. Select No Color from the Color drop-down list.
The Background tab should look like the following:
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39. Click on the Label tab.
40. Select the option No Label.
The Label tab should look like the following:
Appearance Dialog - Label Tab
41. Click OK.
The invoice with the one field will look similar to the one shown below:
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Invoice with "Invoice No" Field
42. Now, create all Field objects on the form on your own. Below is the field name, text
alignment and positioning coordinates you should use for each:
InvoiceDate
Lower Left
x: 6.0625
y: 1.3438
w: 1.8125
h: 0.2444
OrderNo
Lower Left
x: 6.0625
y: 1.5938
w: 1.8125
h: 0.2444
BillTo
Lower Left
x: 0.5000
y: 2.2813
w: 3.4375
h: 1.1875
ShipTo
Lower Left
x: 4.3750
y: 2.2813
w: 3.5000
h: 1.1875
ShipDate
Lower Left
x: 0.4688
y: 3.9375
w: 1.1250
h: 0.2444
Terms
Lower Left
x: 1.6563
y: 3.9375
w: 1.6875
h: 0.2444
ShipVia
Lower Left
x: 3.4063
y: 3.9375
w: 1.9063
h: 0.2444
SalesPerson
Lower Left
x: 5.3750
y: 3.9375
w: 1.4063
h: 0.2444
DueDate
Lower Left
x: 6.8438
y: 3.9375
w: 1.0625
h: 0.2444
QtyOrdered
Top Center
x: 0.5000
y: 4.8438
w: 1.0000
h: 4.1875
QtyShipped
Top Center
x: 1.6250
y: 4.8438
w: 1.0313
h: 4.1875
ItemNumber
Top Left
x: 2.7813
y: 4.8438
w: 1.9063
h: 4.1875
UnitPrice
Top Right
x: 4.8125
y: 4.8438
w: 1.3750
h: 4.1875
Tax
Top Center
x: 6.3125
y: 4.8438
w: 0.5000
h: 4.1875
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ExtPrice
Lower Left
x: 6.9775
y: 4.8438
w: 0.9375
h: 4.1875
Subtotal
Center Right
x: 7.0625
y: 9.1563
w: 0.8125
h: 0.2444
SalesTax
Center Right
x: 7.0625
y: 9.4375
w: 0.8125
h: 0.2444
Freight
Center Right
x: 7.0625
y: 9.7188
w: 0.8125
h: 0.2444
InvoiceTotal
Center Right
x: 7.0625
y: 10.1875
w: 0.8125
h: 0.2444
Your invoice with all of the fields should look similar to the one shown below:
Invoice With All Data Fields
43. Click on the Insert Picture icon on the Drawing toolbar. Insert a company logo or picture of
your choice.
44. Set the Positional Coordinates of the picture to the following (height and width will be
dependent on your picture):
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x: 0.5000
y: 0.5000
45. From the Format menu select Properties. Adjust the picture size and resolution so that the
picture fits in the upper left corner of the invoice.
A sample of the Properties dialog is shown below:
Picture Properties
Your final invoice will look similar to the one shown below:
Final Invoice with Logo
46. Save the invoice as Sample Invoice in the FormDocs Templates directory.
Congratulations, you will use this invoice for the remainder of our examples in the Getting
Started section of this manual.
Download an iSeries Report
The WinSpool/400 Report Download software is used to both download the spool file from the
iSeries system and to convert the file to a specified text format. When viewing available files to
download you can choose to list the files based on the output queue or by OS/400 user.
Samples of each viewing option are shown below:
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WinSpool/400 - Available Downloads by Output Queue
WinSpool/400 - Available Downloads by OS/400 User
Download iSeries Spool File Report
1. Open WinSpool Report Download from the WinSpool Report Download program group.
If this is the first time you have used Report Download, you will be presented with an empty
report list. If you have retrieved possible reports in the past you will see that list on the
screen. Below is a sample if you are a new user to Report Download:
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WinSpool/400 - Empty Report List
2. Enter a valid System Name or IP Address in the System Name/IP Address edit box.
3. Click Refresh.
If you have not already logged onto the iSeries you will be prompted for User ID and
password for the selected system.
Report Download - Sign On Screen
4. Enter a valid OS/400 User ID and Password.
5. Click OK.
This will retrieve a list of valid OS/400 output queues from the selected iSeries. Your screen
will look similar to the one shown below:
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WinSpool/400 Report Download - Ready to Get Report List
6. Select an Queue Name from the drop-down list.
7. Click Get List to retrieve all available reports for the selected queue.
Our example resulted in just one sample report for the selected queue. You may retrieve a
larger list. The screen is shown below:
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WinSpool/400 - Sample Reports
8. Select a report to download. This is done by clicking on the yellow file icon to the left of
the file name.
The top of your screen will change and display Download Options. A sample of the screen is
shown below:
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9. Select RJS Text Layer Designer Format - Text from the Output Format drop-down list.
10. Enable View After Download option. A check mark will be displayed in the option box.
11. Right-click on the selected report.
A submenu will be presented.
12. Select Download Selected Reports from the submenu.
The report will be downloaded and then opened in the Editor. Our sample report is shown
below:
Downloaded Spool File Report
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Congratulations! You have downloaded your first report.
Map Text Layer
The RJS Text Layer Designer software is used to diagram the text data found in your converted
spool files to the defined fields of a FormDocs template. This data mapping enables you to
merge iSeries spool-file data with electronic forms - all within a Window's based PC, so that you
can print documents such as invoices or packing lists on plain paper with the look of a preprinted form.
In this example we will use the invoice designed in the Create A Form section and a sample text
file that was installed with Text Layer Designer. The creation of the text layer definition consists
of 4 steps:
1.
2.
3.
4.
Open Form Template Field List - retrieves defined fields from the FormDocs template.
Create New Report Text Layer - file that contains field mapping information.
Define Text Fields - associates text fields with template fields.
Test Merge - check to ensure forms are filled correctly.
Open Form Template Field List
Remember we will be using the FormDocs template Sample Invoice we created earlier in this
chapter of the manual. The fields defined in the template are used by Text Layer Designer to
match text data to the form data.
Open Form Template Field List
1. Open RJS Text Layer Designer from the WinSpool Electronic Forms program group.
You will be presented with an empty Text Layer Designer screen.
2. From the File menu, select Open Form Template Field List.
Each form template created in FormDocs contains a list of fields (data points) used in the
form. Text Layer Designer maps the spool file text data to one or more of the fields
described in the form template.
3. By default Text Layer Designer will display files found in the WinSpool/400 directory which is
where our the sample files are located. Open the file Sample Invoice.fdt.
You will briefly see the flash screen for FormDocs Filler tool and then your screen will return
to the empty Text Layer Designer screen. Although it appears that nothing has happened,
Text Layer designer has loaded the field information into memory.
Create New Report Text Layer
Now that we have our list of field names from our form template, the next step we need to take is
create a report text layer along with opening a sample text report. This allows you to see the
layout of your report so you can start mapping your data to the appropriate fields. By opening a
report text layer a file gets created in the same folder as the form template with a .TLR
extension.
New Report Text Layer
1. From the File menu, select New Report Text Layer.
Text Layer Designer automatically creates a report text layer with a matching file name to
our sample invoice template. Text Layer Designer uses the file extension of ".TLR". In this
case the file created will be Sample Invoice.tlr. To aid in the readability and diagramming of
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the text layer report you will see the following message:
Text Layer Designer Message
2. Click Yes to open the associated converted spool file.
3. Open the text file invoice.txt.
Your screen should now look similar to the one shown below:
Text Layer Designer Showing New Text Layer Report
Define Text Fields
The third step in creating a text layer for our report is to define the data fields and where they are
located within the text file. Adding a field allows us to know the position of the data that you want
to map to your form. Once you add a field, you will need to associate the field object to one of
your template fields.
Define Text Fields
1. From the Edit menu, select Add Field
If you prefer, use the Add Field toolbar icon:
Add Field Button
Your text layer report now has a field object showing. Your screen will look similar to the one
below:
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Text Layer Report with New Field
2. Click and drag the field object over the invoice date in the top right corner.
The text showing below the field object is the data that will be inserted into the field. In this
example, we see a the data 1/28/97. Your screen should look similar to the one below:
Text Layer Report - Field Positioning
3. Use the sizing handles on both sides of the field object to reduce the field size such that
the edges extend just a little past the data.
Text Layer Designer is able to strip any extraneous spaces from the final data field if your
field is larger than the actual data. This is a nice feature when you have a text field with
variable length. Your screen should look similar to the one shown below:
© 1995-2005 RJS Software Systems
Getting Started
64
Text Layer Designer - Sized Date Field
4. Double-click the field to assign properties.
You will be presented with the Field Properties dialog.
Field Properties Dialog
5. Select InvoiceDate from the Field Name drop-down list.
The list of Field Names was created by opening the Form template Field List - in other
words, the FormDocs template field names.
6. Enable the Trim field data option.
By enabling this option, any spaces prior or at the end of the invoice date will be stripped
from the actual field data. Your completed dialog should look similar to the one below:
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Field Properties - InvoiceDate
7. Click OK.
8. From the Edit menu, select Add Field
9. Click and drag the field object over "Gamba, Joseph R." on the left side of the invoice.
The left-hand side of the field object should be placed just to the left of the customer name
text.
10. Resize the field object so that it is below the zip code line and extends to the center of
the invoice.
Do not cover the next customer/address block. In this case, we will be assigning multiple
lines of text to one field. Your screen should look similar to the one below:
Text Layer Report - Multi-line Field
11. Use the Field Properties dialog to assign this field to ShipTo field and to Trim field data.
12. Continue to create and assign field properties as described below. Make sure to enable the
Trim field data option for all fields. Also, you may need to scroll down the page to either
define the entire field space or to view fields on the lower portion of the page. Special
comments for the creation of the field are listed on the left. hose fields noted with an asterisk
(*) must be multiple line fields. For example, the field ItemNo should extend down the page
until the bottom is just above the area where the invoice summary data is listed.
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BL 03012
InvoiceNo
1001
OrderNo
Gamba, Joseph R
ShipTo
UPS Ground
ShipVia
Net 30 3
Terms
01/28/97
InvoiceDate
This is the first of three dates on this line.
02/27/97
DueDate
This is the second of three dates on this line.
02/07/97
ShipDate
This is the third of three dates on this line.
3
SalesPerson
Ensure field extends a little to left and right of this value.
MX100
ItemNo
Extend the length of this field until the bottom is just
This is the right-side address block. Include all address
lines.
above
Easy chair the area where the invoice summary data is
listed.
3.00
0.00
QtyOrdered
Extend the length to be equal to ItemNo.
3.00
QtyShipped
Extend the length to be equal to ItemNo.
349.00
UnitPrice
Extend the length to be equal to ItemNo.
Y
Tax
Extend the length to be equal to ItemNo.
1047.00
ExtPrice
Extend the length to be equal to ItemNo.
1047.00
Subtotal
You may need to scroll down to find this field. It is
located near the bottom of the page.
94.23
SalesTax
0.00
Freight
1141.23
InvoiceTotal
Your text layer report should look similar to the one shown below:
© 1995-2005 RJS Software Systems
67
RJS Electronic Forms
Text Layer Report - Sample Invoice
The text layer report is ready to be tested. See the following section Test Merge for
instructions.
Test Merge
The Test Merge feature is used to ensure all fields have been properly assigned to template
fields and that the final form is correctly filled with the spool file data.
Test Merge
1. From the File menu, select the Test Merge.
If you prefer, use the Test Merge toolbar icon:
Test Merge Button
Since we have not saved our report, you will be prompted to save.
Run Test Merge - Save Report Layer Message
2. Click Yes to save your text layer report.
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You will be presented with a message to view the test merge.
Test Merge Success Message
3. Click OK.
You will be presented with a pdf file that includes five sample invoices. Scroll through your
invoices. The first invoice should look similar to the one shown below:
Test Merge - Completed Invoice Samples
Congratulations! You have successfully created a form template, text layer report that merges
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spool file data.
Automate through Print Server
The WinSpool/400 Print Server can be used to automate your electronic forms process.
WinSpool/400 Print Server is designed to monitor output queues on the iSeries and then initiate
the spool file downloads when output queues become available on the server and finally to fill
and print forms accordingly. In other words, the Print Server integrates all of the individual tools
to actually download spool file data and insert that data into the correct forms for printing.
In this example, you will set up the WinSpool/400 Print Server to monitor a default WinSpool
output queue and use the invoice template to print five invoices.
Print Server Automation Task
1. Open Electronic Form Print Server from the WinSpool Electronic Forms program group.
You will be presented with the Print Server main screen.
Electronic Form Print Server Main Screen
2. From the Table Entry menu, select Edit System List.
The system list maintains the details necessary to establish an active session with one or
more iSeries systems. A sample connection is created when you install the software. You
will be presented with the System List screen.
Default System List
3. Click in the yellow cell of the AS/400 System or IP Address column. Enter a valid iSeries
system name or IP address.
4. Enter a valid OS/400 User ID in the AS/400 User field.
5. Enter a valid password for the given user ID.
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Password value will initially be seen in the field as you enter it. The value is encrypted as
soon as the cursor is moved to a different field in the table.
6. Ensure the Activate field is enabled.
A check mark will be displayed in the box.
7. De-select the Activate field for the default system 1.1.1.1.
Note: If you prefer to delete the sample data row, click on the arrow button to the left of the
row and then press your delete key. This will remove the line from the data file. If you would
like to keep the sample row for reference, disable the activate option which maintains the
data row but will not attempt to communicate with the noted system when the print server is
running.
Your screen should look similar to the one shown below:
Updated System List
8. Click in any cell of the last row in the table.
If a cursor remains in one of the cells of the new row of data, it is assumed you are in edit
mode for the field. You must complete the field edit by moving the cursor to an empty cell.
9. Click OK.
10. From the Table Entry menu, select Edit Output Queue List.
The Output Queue List maintains the details that will link system and output queue to a
particular forms processing method, FormDocs or Reform, and instructions on what to do
with output queues once processed by the Print Server. You will be presented with the
default Output Queue list:
Default Output Queue List
11. Click in the yellow cell of the Output Queue column. Enter WSPEFORM as the Output
Queue.
12. Enter QGPL in the Library field.
13. Enter the text Electronic Forms Test Output Q in the Description field.
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14. Enter a valid iSeries system name or IP address in the AS/400 System or IP Address field.
15. Ensure the Activate field is enabled.
A check mark will be displayed in the box.
16. De-select the Activate field for the default system 1.1.1.1.
Note: If you prefer to delete the sample data row, click on the arrow button to the left of the
row and then press your delete key. This will remove the line from the data file. If you would
like to keep the sample row for reference, disable the activate option which maintains the
data row but will not attempt to communicate with the noted system when the print server is
running.
17. Click in the Output Format field. A down-arrow button will appear. Select FDC from the list.
Your screen should look similar to the one shown below:
Updated Output Queue List
18. Select Do Nothing from the After Processing Option field.
By selecting Do Nothing during our test period we ensure that the spool file remains
unchanged and available for use during our testing period. For testing purposes, we
recommend that the After Processing Option is always set to Do Nothing. Once testing is
complete this option can be changed to the appropriate processing option. Refer to the
Electronic Form Print Server chapter in this manual for additional help on this option.
19. Click OK.
20. From the Table Entry menu, select Edit Print Output Directory List.
The Print Output Directory list maintains the detailed instructions for merging data and
printing forms. You will be presented with the Print Output Directory List screen.
Default Print Output Directory List
21. Click in the yellow cell of the Output Queue column. Enter WSPEFORM as the Output
Queue.
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22. Enter QGPL in the Library field.
23. Enter a valid iSeries system name or IP address in the AS/400 System or IP Address field.
24. Click on the Directory Browse button and select the desired PC directory.
If you installed WinSpool/400 into the default directory of C:\WSPEFORM then you can
accept the displayed default directory. If you changed the WinSpool/400 installation
directory to another directory, such as within Program Files, you should enter C:\Program
Files\WSPEFORM\SPOOLER.
25. Enter a desired description of the directory in the Output PC Directory.
26. Ensure the Activate field is enabled.
A check mark will be displayed in the box.
27. Enter 1 into the Print Copies field.
28. Click in the Windows Printer for HTML/FormDocs Printing field - you will need to scroll to
the far right to see this field. A drop-down selection button will appear. Select the desired
printer to use for printing sample forms.
Leave all other fields as is. Default values will server our sample well.
29. De-select the Activate field for the default system 1.1.1.1.
30. Click in the Output Queue field of the last row - you will need to scroll to the far left.
Your screen should look similar to the one shown below:
Updated Print Output Directory List
31. Click OK.
All necessary table entries have been created so that your WinSpool/400 Print Server can
monitor a sample output queue and then use the data to print invoices using the FormDocs
template.
32. Click the Start Print Server button.
The Print Server will then establish a connection to the desired iSeries and start to monitor
the output queue. As this happens you will notice several progress messages being
displayed in the lower section of the screen. Below is a sample screen noting the message
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area:
Print Server Message Area
If everything is correctly set in the Print Server environment you should see a message
Converting Report to FormDocs Document Format and then the forms should print on your
printer. If you receive error messages, note the errors and attempt to change necessary
settings. If you are unable to diagnose the problem on your own, contact RJS Software
Systems Support staff.
Quick Tips
This section is designed to offer a few hints and techniques that can save you time or simply the
use of WinSpool/400 software. They are arranged by product.
FormDocs Techniques
Trace Form
The FormDocs Trace Form features aids in the quick development of an electronic version of a
form that was a pre-printed paper form. If you have a form, such as an employment application,
that you would like to convert to a digital template the Trace Your Paper Form option reduces the
time needed to recreate the form. To use a form, scan the blank form; by scanning in black and
white mode you will have the ability to control color and resolution of the traced form. Once the
paper form has been scanned it is imported into your FormDocs template and looks similar to a
watermark. If you are using a black and white image, you can choose the color and the
resolution of the traced form. Once displayed on the form, all you need to do is to draw your
template objects over the traced image.
Quick steps to Trace Paper Form
1. From the Tools menu, select Trace Your Paper Form.
2. From the submenu, select Scan your Form. You will have the option to use an existing
image or scan a new form. Scan the document in black and white mode.
3. Select the desired scanner to use or select an image file.
4. Set your Trace Properties: color, resolution and positioning of the image.
5. Create your form!
Below is a sample of a new FormDocs template where we have included a traced paper form:
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Traced Form
Duplicate Objects
FormDocs gives you the ability to create multiple objects based on one selected object. For
example, if you were creating a template that has five rectangular boxes, all the same height and
width, that need to be tightly placed across the page the Duplicate Object makes quick work of
the task. When you create duplicate objects you can specify the number of additional objects to
create, choose a direction to lay out the objects and specify an exact offset for each new object.
Using this feature gives you the ability to create precise object layout in very little time. Any
object type can be duplicated.
Quick steps to Duplicate an Object
1. From the Edit menu, select Duplicate.
2. Specify the number of objects to create.
3. Specify the object offset. By specifying zero each new object will be butted up against the
last object.
4. Choose the direction to layout the objects: up, down, left or right.
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Text Layer Designer Techniques
Check for Unmatched Form Fields
As you design text layer reports you can use the Text Layer Designer feature to verify if all
FormDocs template fields have been mapped to fields in the selected FormDocs template.
When you check for unmatched form fields, Text Layer Designer will return a list from 0 to n of
FormDocs template fields that have not yet been assigned a field in Text Layer Designer or Text
Layer Designer fields that have not yet been assigned to FormDocs template fields.
Check Unmatched Form Fields
1. From the Edit menu, select Check for Unmatched Form Fields.
2. Review the list of template fields not yet assigned to text layer report fields. If all fields
have been mapped, you will receive an empty message box.
- or 1. Click on the Check for Unmatched Form Fields icon on the toolbar.
Note: Periodically the Unmatched Form Fields feature does not refresh properly. When this
happens your results list will include fields you know have been assigned. When this
happens close the Text Layer Report, refresh the field list and then re-open the Text Layer
Report.
Field that References an Image
If would like to have a form that has a dynamic image, such as a different logo depending on the
company division printing the form, embed an image path/filename into a field and denote the
field is an image on the Field Properties. When data is merged with the template Text Layer
Designer will retrieve the image file and display the image on the filled form. Image file
referenced must be a picture object.
Removing Extraneous Spaces from Fields
As you create fields in Text Layer Designer, you can be generous with the width of fields since
you can set the field properties to remove spaces from the beginning and the end of the text
being placed in the field. This field is especially helpful when you are working with variable
length text. For example, the length of text used on an invoice for product description might be
as little as 15 characters or up to 60 characters. By creating a field that can intake the maximum
characters, trailing spaces (or for that matter, leading blanks) can be eliminated.
Quick steps to Eliminate Leading/Trailing Spaces
1. Double-click on the desired field to modify Field Properties.
2. Enable the option Trim Field Data from the Field Property list. A check-mark should be
displayed to the left of the option if it is enabled.
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WinSpool/400 Report Download
This section describes all basic settings and menu options for RJS WinSpool/400 Report
Download.
File
This section contains a description of each option found on the File menu.
Settings
The Settings option allows you to customize your Report Download software environment. There
are two tabs associated with the Settings dialog: Options and Work Files.
Options Tab
Below is a sample of the Settings dialog and a description of each option available.
Settings Dialog - Options Tab
Minimize while downloading spool file
When enabled, the Report Download software will minimize itself and run in the background of
Windows. This allows your users to continue working on other tasks while reports are being
downloaded.
Use Template Output File Name
If this option is enabled, WinSpool/400 will automatically name any spool files which are selected
for downloading based on the template file, Counter Format and Max Counter Value information
entered. As an example, if the Template File Name is "SPOOL" and the counter contains six
digits then the file naming sequence would be SPOOL000000.TXT, SPOOL000001.TXT,
SPOOL000002.TXT, etc.
This option is useful when multiple reports will be downloaded. The alternative would be to name
each PC file manually.
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Display AS/400 Error Messages
When enabled all error messages received from the WinSpool API will be displayed.
Truncate trailing spaces during download
When using APPC connectivity and this option is enabled, WinSpool/400 will truncate any
trailing blank spaces found in a spool file being downloaded. Each record will end with a carriage
return/linefeed combination.
Note: This option can significantly reduce the size of a downloaded spool file when used with
the APPC connectivity. In some cases, report sizes can be decreased up to 50%. This
setting is not needed for TCP/IP connectivity.
Use Security
By enabling this option, the user must sign on to WinSpool/400 with a valid OS/400 user ID and
password prior to downloading any spool files. A sign-on dialog box will automatically be
displayed if security is enabled and a user has not already signed on to the selected AS/400
system. It is recommended that this option be enabled
If this option is not enabled, the user ID and password entered at the router level will be used to
determine which AS/400 user is using the WinSpool/400 software. Some companies use a
generic user ID and password for the router, so security problems can sometimes occur if a
generic router user ID and password are used.
Use Template Output File Extensions
If this option is enabled, WinSpool/400 will use the extension specified in the Template Ext.
option on the Work Files tab of this dialog.
Use Numeric Template Output File Extensions
If you would prefer to denote the sequence of downloaded reports by using the extension as a file
counter, enable this option. When enabled, WinSpool/400 will append a numeric file extension
to the PC report output file name. In some situations it may be advantageous to omit the usage
of the Template Output File Extensions.
Pass Most Recent File to Monarch and dataImport
If this option is enabled, WinSpool/400 will pass the most recent report file downloaded to the
DataImport Report Mask program or to the Monarch program if the respective programs are
currently running. Either program can easily be started using the Run Programs toolbar on the
left-side of the application or by using the equivalent menu option.
Note: This option can typically be circumvented by using the Send to DataImport Mask or
Send to Monarch Output Format when downloading a report.
Use TCP/IP Connectivity
When this option is enabled, the WinSpool/400 software will use the 32-Bit TCP/IP API for
downloading reports.
The WinSpool/400 TCP/IP API uses the OS/400 FTP Server so the OS/400 FTP Server must be
running. If you're not sure whether your FTP Server is running, run the following command from
an OS/400 command line to determine if the FTP server is running:
NETSTAT OPTION(*CNN)
From the Work with TCP/IP Connection Status screen, you will see a column titled Local Ports.
Under the Local Ports column there should be an entry that says: ftp-con. If you see the ftp-con
entry, the OS/400 FTP Server is running. Below is a sample screen where ftp-con is currently
active:
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Work with TCP/IP Connection Status - Active ftp-con
If the OS/400 FTP Server is not running, you can use the following OS/400 command to start it:
STRTCPSVR SERVER(*FTP)
Note: It is recommended that you use TCP/IP connectivity instead of the NetSoft Router if
possible. TCP/IP provides a far more stability and up to five-times faster download
performance. Our benchmark tests have shown that the WinSpool/400 TCP/IP API's can
typically download up to 1000 pages in 1-2 minutes.
This entry is enabled by default.
Use RJS DataImport Report Convertor
This setting is used only for evaluation purposes when a customer wants to test the DataImport
functionality without the standard 100 record limit in the DataImport Demo Version. The
customer has to first install the WinSpool/400 DataImport Report Converter software and then
enable this option. This functionality must be disabled after 30 days or once the permanent
version of the DataImport software has been purchased from RJS Software Systems and loaded
on the PC.
Generate Job Log After Download Pass
This setting determines whether the WinSpool/400 software will force the OS/400 to print a job
log after each report server polling cycle. If you are getting unexplainable errors such as "Invalid
Command Response" from any of the OS/400 commands, the OS/400 job log can help to
explain why the errors are occurring.
The job log will be created using the OS/400 user ID that was entered for the first download.
Debug view After Download Option
When enabled, the Download Log is automatically displayed.
Use Command Line to Call MS Excel
When enabled, Microsoft Excel is called using Windows command line.
Available System List
This setting allows you to provide a list of acceptable system names or IP addresses in the
System Name/IP Address pull-down. The list of values should be entered using a semicolon (;)
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to delimit the list. This setting only needs to be used if you are using TCP/IP connectivity and
want to soft code a list of available systems.
Example System List: 125.1.1.1;S1052546;125.1.1.55
PCL to PDF Convert Options
This setting allows the conversion of PCL to PDF.
Contact RJS Software Systems Inc if you have questions regarding the available conversion
options. This setting can only be used if you are using TCP/IP connectivity.
Launch After Wait
Enter, in seconds, the amount of time to wait prior to launching PCL to PDF conversion.
Use Command Line to Call MS Word
If this setting is enabled, Microsoft Word will be opened using the command line in the edit box
MS Word Command Line.
MS Word Command Line
The value in this field specifies the path and command to use to open Microsoft Word.
Zip File Extension
The value in this field specifies the extension to use when compressing files.
Counter Format
The value in this field specifies the number of digits to use when appending a numeric value to
template file name.
Max Counter Val
The value in this field specifies the maximum value to be used when appending numeric values
to template file names.
Use WinSock API for Remote Commands
When enabled, remote system commands will use the WinSock API.
Reform Designer Command Line
The value in this field specifies the directory path and command to be used when opening
FormDocs Form Designer. The default command for this application will be "C:\Program
Files\FormDocs\FDD.EXE".
RJS Text Layer Designer Command Line
The value in this field specifies the directory path and command to be used when opening RJS
Text Layer Designer.
WinSpool/400 Report Index Editor
The value in this field specifies the directory path and command to be used when opening
WinSpool/400 Report Index Editor.
Library List
This setting allows you to change the OS/400 library list for the current user. The list of values
should be entered using a semicolon (;) to delimit the list.
Work Files Tab
Below is a sample of the Settings dialog and a description of each option available.
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Settings Dialog - Work Files Tab
Output Directory
This field contains the directory path WinSpool/400 will use to store all output files created during
processing.
Template File Name
This field stores the text prefix that will be used when the Use Template Output File Name option
is enabled on the Options tab. If, for example, you enter SPOOL as the Template File Name all
output file names will begin with SPOOL and then a numeric counter will be appended to the
text.
Template Counter
This field stores the next value to be used as part of the Output File name. This value is
concatenated with the text provided in the field Template File Name to create a unique Output
File Name. For example, if the Template File Name contains the text SPOOL and the Template
Counter contains 4, the next Output File Name will be SPOOL000004.
Template Ext.
This field contains the text to use as the file extension when naming new Output Files. For
example, if the Template Ext. contains TXT, the output file will be given a file extension of TXT.
Spool Listing Work File
This field contains the directory path and name of the PC file WinSpool/400 will use when
retrieving output queue listings from the iSeries. This work file stays on the PC and can be used
until a new spool file listing is requested from the iSeries.
Output Queue Listing Work File
This field contains the name of the directory path and PC file WinSpool/400 will use when
retrieving a listing of all output queues from the iSeries. This work file stays on the PC and can
be used until a output queue listing is requested from the iSeries.
Spool Preview Work File
This field contains the directory path and name of the PC file WinSpool/400 will use when
retrieving and displaying a spool file sample from the iSeries. This work file stays on the PC and
can be used until a new spool file listing is requested from the iSeries.
Monarch Command Line
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This field contains the directory path and name of the PC program WinSpool/400 will call when
Monarch is chosen from the Run Programs menu.
DataImport Report Translate Cmd
This field contains the directory path and name of the PC program WinSpool/400 will call when
DataImport Report Translate is chosen from the Run Programs menu. This option is only valid if
you have DataImport for Windows. The DataImport software can be purchased from RJS
Software Systems as a separate option for WinSpool/400. DataImport allows reports to be
converted from ASCII text format into Lotus 123, Microsoft Excel, Dbase, Microsoft Access, or
many other PC file formats.
Spool Download Work file
This field contains the directory path and name of the temporary PC file WinSpool/400 will use
when retrieving a spool file from the iSeries with the Download and Reformat button. This file will
be deleted automatically after a report is successfully downloaded and reformatted by
WinSpool/400.
Default DataImport Mask Directory
This field contains the directory path and name of the default directory displayed when the Select
Mask File dialog is shown when sending a report using the Send to DataImport Translate option.
Skin Path
Just like Window's provides different themes that can be used to change the color schemes of
your Windows environment, WinSpool/400 Report Download provides several different skins that
can be applied to change the look and feel of Report Download. Use the button with the three
ellipses to the right of the field to select a skin. Once selected, click the Apply button. The user
interface for the package will change to the selected skin. Below is what your screen will look
like if you choose the chizh skin:
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WinSpool/400 Report Download with Chizh Skin Applied
DataImport Report Masking Cmd
This field contains the directory path and name of the PC program WinSpool/400 will call when
DataImport Report Mask is chosen from the Run Programs menu. This option is only valid if you
have DataImport for Windows. The DataImport software can be purchased from RJS Software
Systems as a separate option for WinSpool/400. DataImport allows reports to be converted from
ASCII text format into Lotus 123, Microsoft Excel, Dbase, Microsoft Access, or many other PC
file formats.
File Manager Command Line
This field contains the name of the PC program WinSpool/400 will call when File Manager is
chosen from the Run Programs menu. The default value for this field is EXPLORER.EXE.
Editor Command Line
This field contains the name of the PC program WinSpool/400 will call when Editor is chosen
from the Run Programs menu. The default value for this field is NOTEPAD.EXE.
User Application 1 Command Line
This field contains the directory path and name of the PC program WinSpool/400 will call when
User Application 1 is chosen from the Run Programs menu.
User App Desc 1
This field contains the description of User Application 1. This description will replace the text
"User Application 1" on the Run Programs menu of WinSpool/400. When a user selects this
option, the application program listed in the field User Application 1 Command Line will be
called.
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User Application 2 Command Line
This field contains the directory path and name of the PC program WinSpool/400 will call when
User Application 2 is chosen from the Run Programs menu.
User App Desc 2
This field contains the description of User Application 2. This description will replace the text
"User Application 2" on the Run Programs menu of WinSpool/400. When a user selects this
option, the application program listed in the field User Application 2 Command Line will be
called.
WinView/400 Command Line
This field contains the directory path and name of the PC program which WinSpool/400 will call
when asked to send a report to the WinView/400 Viewer.
Router Status
The Router Status option is used to connectivity to the iSeries system currently displayed in the
System Name/IP Address list box. This option will open a command window and execute the
command PING.EXE. A successful router test will note if replies were received from the iSeries.
Below is a sample of a successful test:
Router Status - Successful PING Test
Session
This section contains a description of each option found on the Session menu.
Sign On
The Sign On option allows you to sign-on to the iSeries. You must enter a valid OS/400 user ID
and password. You will not be allowed to retrieve lists of available output queue files or
download reports without a valid OS/400 user ID and password.
Sign Off
The Sign Off option will end the current session for the current OS/400 user. If you sign-off of
the current session you will not be allowed to download any additional reports until a new session
is established using the Sign On menu option.
Log
This section contains a description of each option found on the Log menu.
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View Download Log
The View Download Log option displays the WinSpool/400 download log. Download activities
continue to be appended to the end of the log file until you clear the file using the menu option
Clear Download Log. Log file includes download start/stop times, report downloaded and PC file
location. The log file is viewed using the application noted in the Editor setting, typically
Notepad. Below is a sample of a download log file:
Report Download - Download Log
Clear Download Log
The Clear Download Log option will remove all log entries from the download log file. When the
option is selected you will be prompted to confirm the clear request.
Run Programs
This section contains a description of each option found on the Run Programs menu.
Explorer
The Explorer option calls the PC program entered in the File Manager Command Line field,
found on the settings dialog. Typically Window's Explorer is called.
Form Designer
The Form Designer option calls the PC program entered in the Reform Designer Command Line
field, found on the settings dialog. Typically FormDocs Form Designer is called.
Report Index Editor
The Report Index Editor option calls the PC program entered in the WinSpool/400 Report Index
Editor field, found on the settings dialog. Typically RJSNOTES.exe software is called.
Monarch
The Monarch option calls the PC program entered in the Monarch Command Line field, found on
the settings dialog. Typically Monarch software is called. You must have Monarch software
installed on your system for this command to work.
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DataImport Mask
The DataImport Mask option calls the PC program entered in the DataImport Report Masking
Command Line field, found on the settings dialog. Typically WinSpool/400 DataImport Report
Converter software is called. You must have WinSpool/400 DataImport Report Converter
software installed on your system for this command to work.
WinView Report Viewer
The WinView Report Viewer option calls the PC program entered in the WinView/400 Command
Line field, found on the settings dialog. Typically RJS WinView/400 Report Viewer software is
called. You must have RJS WinView/400 Report Viewer software installed on your system for
this command to work.
MS Word
The MS Word option calls the PC program entered in the MS Word Command Line field, found
on the settings dialog. Typically Microsoft Word software is called. You must have Microsoft
Word software installed on your system for this command to work.
MS Excel
The MS Excel option calls Microsoft Excel. You must have Microsoft Excel software installed on
your system for this command to work.
User Application 1
WinSpool/400 Report Download gives you the ability to create both a customized Run Programs
menu and toolbar such that two user applications can be displayed and opened from Report
Download. Once customized, see the Settings - Options section for additional help, The User
Application 1 menu item will be changed to display the custom description provided. The
program called will be the PC program entered in the User Application 1 Command Line field,
found on the settings dialog.
User Application 2
WinSpool/400 Report Download gives you the ability to create both a customized Run Programs
menu and toolbar such that two user applications can be displayed and opened from Report
Download. Once customized, see the Settings - Options section for additional help, The User
Application 2 menu item will be changed to display the custom description provided. The
program called will be the PC program entered in the User Application 2 Command Line field,
found on the settings dialog.
Help
This section contains a description of each option found on the Help menu.
Contents
The Contents option opens the WinSpool/400 online help.
About
The About option displays WinSpool/400 version information and RJS Software Systems contact
details. Software version information is helpful when you call our support staff. From this screen
you can also display basic system details of your PC or quickly access the RJS Software
Systems website. A sample of the screen is shown below:
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WinSpool/400 Help About Screen
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Text Layer Designer
This section describes all basic settings and menu options for RJS Text Layer Designer.
File Menu
This section contains a description of each option found on the File menu.
Open Form Template Field List
The Open Form Template Field List option is utilized to pull a list of all the field names from a
FormDocs template. Text from converted spool files will be mapped to these fields to enable a
merge of text in one format with the FormDocs template.
New Report Text Layer
The New Report Text Layer option creates either a new report text layer, if one does not exist for
the selected FormDocs template, or overwrite the existing report text layer.
Whenever a new report text layer is created you will be prompted to view an associated text file.
By choosing to open a text file you will be able to see the format of the text file which will enable
you to quickly map text file data to FormDocs template fields.
Open Report Text Layer
The Open Report Text Layer option allows you to open an existing report text layer and then
make any necessary modifications. If a report text layer has not been created for the current
FormDocs template you must use create a new report text layer. Refer to the previous section
for details. Remember, you must first open your form template field list before you can open the
associated report text layer.
When you open a report text layer you will not be prompted for a file name. This is because the
report text layer file name must match the FormDocs template name. Text Layer Designer will
always look for a matching file name to the FormDocs template when opening a report text layer.
Again, just like the New Report Text Layer you will be prompted to view a text file with the report
text layer. Viewing a text file displays the format of the text files you will be using to fill the
FormDocs templates.
Save Report Text Layer
Use Save Report Text Layer option to save your progress as you define your report text layer.
Remember, you will not be prompted for a file name when you first save your report text layer as
Text Layer Designer will name the file using the same name as the FormDocs template. Report
Text Layer files have a file extension of .TLR.
Test Merge
Use the Test Merge option to check your text layer data mapping with the FormDocs template
and sample data. Once the test merge is complete you should receive a success/failure
message from Text Layer Designer. If your test is successful, a PDF file will be created and
opened for you to view. Page through the completed form(s) to ensure data is properly placed in
the forms and that forms are filled as expected.
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Open Report Text File
Use the Open Report Text File option to view the format of your downloaded spool file data. You
must first open your form template field list and create/open your report text layer prior to
opening a report text file. The same function is available at the time you create/open a report
text layer; each time a text layer is created or opened you are prompted to open a report text file
for viewing.
Close Report Text File
Use the Close Report Text File option to close an existing report text file that you are viewing.
Open Form in Designer
Use the Open Form in Designer to open a desired template in FormDocs Designer. This
command will launch FormDocs Designer and open the selected template for viewing/editing.
Launch Form Designer
This option will open the FormDocs Designer application.
Launch Form Filler
This option will open the FormDocs Filler application.
Edit Menu
This section gives an overview of the RJS Text Layer Designer Edit menu and the available
options.
Add Field
The Add Field option is used to insert a new field into the report text layer. If you attempt to add
a field prior to opening your form template field list and creating/opening your report text layer
this command will be ignored. When you select this menu option a new field will be inserted at
the top left portion of the report text layer. You can then move the field and define field
properties; refer to the Getting Started, Map Text Layer portion of this manual for detailed help in
these tasks.
Check for Unmatched Form Fields
Use the Check for Unmatched Form Fields option to list all FormDocs template fields that have
not yet been mapped to a Text Layer Designer field or any Text Layer Designer fields that have
not yet been mapped to a FormDocs template field.
First Page
This option allows you to jump to the first page of the report text file that you are viewing.
Previous Page
This option allows you to navigate to previous pages of the report text file that you are viewing.
Next Page
This option allows you to navigate to the next page of the report text file that you are viewing.
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Last Page
This option allows you to jump to the last page of the report text file that you are viewing.
Explorer Menu
This section gives an overview of the RJS Text Layer Designer Explorer menu and the available
options.
Forms Template Directory
This option will open the Template folder within the FormDocs folder using Windows Explorer.
Help Menu
About
This menu option will give you the current version of RJS Text Layer Designer software that you
are using. It will also give you RJS Software Systems current contact information.
Toolbar
Below is the Text Layer Designer toolbar with associated icon labels:
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Electronic Form Print Server
This section describes all basic settings and menu options for WinSpool/400 Print Server.
File
This section contains a description of each option found on the File menu.
Settings
The Settings option allows you to customize your WinSpool/400 Print Server environment.
There are four tabs associated with the Settings dialog: Options, Work Files, Reform Options and
FormDocs Options.
Options Tab
The Options tab is used to set general Print Server environment options. Each Option is
described below:
Settings Dialog - Options Tab
AS/400 Polling Interval
This option determines how often Print Server will converse with the iSeries system to determine
if there are qualified spool files in the designated output queues. The value entered in this field
is in minutes. It is recommended that the polling interval is set to 5 to 15 minutes.
Display Error Messages (Enable during testing or troubleshooting.)
When this option is enabled Print Server will display all error messages in the message section
of the main Print Server screen. This is especially helpful when you first start using Print Server
or when you are experiencing troubles. More detailed messages can be found in the error log
file.
Log Messages to Log File
When this message is enabled all processing messages will be appended into the Print Server
Log file. The log file is an audit trail of report downloads as well as errors which occur during
downloading. The file name and location can be found in the field Log File Name found on the
Work Files tab.
This entry is enabled by default.
Use TCP/IP Connectivity
When this option is enabled, the WinSpool/400 Print Server will use the 32-bit TCP/IP API for
downloading reports. In order to use the TCP/IP connectivity, the 32-bit WinSpool/400 TCP/IP
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OLE Server program must be installed on the PC as well as the WinSpool/400 software.
Generate Joblog After Each TCP/IP Pass
When enabled, an OS/400 Joblog will be created after each TCP/IP pass. In other words, each
time that the iSeries system is polled by the Print Server a joblog will be created.
Run in System Tray
This setting determines whether the Print Server program runs in the system tray found on the
far right side of the Taskbar. When enabled, Print Server window disappears when minimized
and reappears when the system tray icon is clicked or right-clicked. this is handy if you want the
Print Server to typically run on the system without visually disturbing the user.
Use In-Process TCP/IP ActiveX DLL
This setting determines whether the WinSpool/400 TCP/IP API functionality runs in the same
program address space as the Print Server program or whether it gets loaded as a separate 32bit process. You should never disable this option unless instructed by RJS Software systems
support personnel.
Display Confirmation Messages
This setting determines whether the user is asked to confirm their choice each time the report
server process is started. stopped or the program is exited. This setting only needs to be
enabled for users who are less cautious in there option selection.
This entry is disabled by default.
Use Daily Scheduled Times
When this option is enabled, Print Server will automatically start running to monitor and
download reports. The application will open at the time stated in the field Start Hour. The
application will close at the time stated in the field End Hour. This field makes it easy for you to
consistently and regularly print electronic forms without manually needed to open the application
and start the Print Server.
Start Hour
Enter the starting hour for processing spool-file reports. Value must be entered as an integer and
be between 1 and 24. If you enter 14, Print Server will start at 2:00 pm.
End Hour
Enter the ending hour for processing spool-file reports. Value must be entered as an integer and
be between 1 and 24. If you enter 3, Print Server will stop processing at 3:00 am.
Program Shutdown Time
Enter the time you would like Print Server to close down. You may enter both hour and minutes
for your shutdown time. Value should be entered in the format HH:MM, where HH represents the
hour of the day using a 24-hour clock and MM represents minutes.
Enable Postscript to PDF via Distiller
When enabled, postscript reports can be converted to PDF format using Adobe Distiller tool.
Adobe Distiller must be installed and operating on the PC that is running WinSpool/400 Print
Server.
Enable 1024 byte AS/400 command lines
When enabled, print server can send extended command line text to the iSeries system when
processing reports. The extended text may be needed if you are using extensive search criteria.
This option must be enabled if you are re-spooling back to an output queue on the iSeries.
Enable rename instead of copying work file
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When enabled, disk space can be saved by renaming report files once processed rather than
copying them to a different directory.
Enable Use Specific Select
When enabled, allows the user to use the "Use Specific Search Criteria" option located in the
Edit Print Output Directory List. The Use Specific Search Criteria feature will fail if this option,
Enable Use Specific Select, is not enabled. The Print Output Directory List can be found by
accessing File | Settings from Electronic Form Print Server menu bar.
Work Files Tab
The Work Files tab is used to set file locations and program choice for standard files used by
WinSpool/400 Print Server. Each Option is described below:
Settings Dialog - Work Files Tab
Settings Database
Enter the filename and location for the Microsoft Access database file that will maintain all
settings available to Print Server. The default location will be based on where you installed
WinSpool/400 Electronic Forms; typically the path will be either c:\Program Files\WSPEFORM
or c:\WSPEFORM. The settings database file is wspeform.MDB. Do not change the name of
the settings database.
Output Queue List Work File
This field contains the name and location of a PC work file used by Print Server as temporary
storage for the OS/400 report lists during processing. The default location will be based on
where you installed WinSpool/400 Electronic Forms; typically the path will be either c:\Program
Files\WSPEFORM or c:\WSPEFORM. The Output Queue List work file is wspeform.Q. Do not
change the name of the work file.
Log File Name
This field contains the name and location of a PC work file, which is used as temporary storage
for the all Print Server processing messages. The log file will contain an audit trail of successful
and unsuccessful report downloads.
Log File Viewer Program
This field contains the command line used to call a viewer that will be used to display the log file.
By default, Windows Notepad will be called.
Use WinSock API for Remote Commands
When enabled, Print Server will use WinSock API protocol when issuing remote commands.
Reform Location
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This field contains the location of the RJS Reform software.
Spool File Temporary Work File
This field contains the name and location of a PC work file that is used by the Reform Spooler.
Reform Options Tab
The Reform Options tab is used to set options specific to long-time Reform software users. The
settings on this tab are only pertinent to RJS Reform clients. This section does not apply to
FormDocs clients. Each Option is described below:
Settings Dialog - Reform Options Tab
Path to Reform Spooler Directory
This field contains the directory path to be used by the Reform Spooler.
Path to Reform Program Directory
This field contains the directory path to be used when calling the Reform application file.
Path to Reform Backup Directory
This field contains the directory path to be used by Reform for all backup activity.
Amyuni PDF Converter Temporary Work File
This field contains the name and location of a PC work file used by the Amyuni PDF converter.
By default, the file name is wspeform.AMU.
Amyuni PDF Converter Printer Name
This field contains the specifics needed by Amyuni PDF Converter for printing. Either specify a
unique printer or use the generic "PDF Compatible Printer Driver".
Enable Reform Report Conversion
When enabled, Reform can call report conversion programs such as Amyuni.
Enable Auto Start Reform without Prompting
When enabled, Reform processing can begin without prompting the user for confirmation to start.
Enable Amyuni PDF Writer Support
When enabled, Amyuni report conversion can be done using PDF Writer support or commands.
FormDocs Options Tab
The FormDocs Options tab is used to set options specific to FormDocs software clients. This
section does not apply to Reform clients. Each Option is described below:
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Settings Dialog - FormDocs Options Tab
Path to FormDocs Directory
This field contains the directory path to be used when calling the FormDocs application file.
Path to FormDocs Template Directory
This field contains the directory path to be used when looking for FormDocs template files.
Enable FormDocs Report Conversion
When enabled, FormDocs can call report conversion programs such as Amyuni.
Exit
The Exit option will close WinSpool/400 Print Server.
Table Entry
This section contains a description of each option found on the Table Entry menu.
Edit System List
The system list maintains the details necessary to establish an active session with one or more
iSeries systems. A sample system connection entry is created when you install the software.
There are no limitations to the number of systems you can maintain in your system list.
However, each time you start the Print Server it will attempt to connect and download data from
every system that has been activated. Creation of a new entry is as simple as clicking and
entering data into each cell of the line highlighted in yellow. Editing an existing entry is done by
clicking in the cell(s) that contain outdated or inaccurate data and changing the data. Changes or
additions will be committed to the database when you click on any cell in a different row than the
one you are editing.
A sample system list will look similar is shown below:
Print Server Default System List
© 1995-2005 RJS Software Systems
Electronic Form Print Server
98
Each available field is described below:
AS/400 System Name or IP Address - Required Field
Enter a valid DNS system name or IP Address for the desired iSeries system.
AS/400 User - Required Field
Enter a valid OS/400 user ID for the desired iSeries system.
Password - Required Field
Enter the associated password for the user ID entered in the AS/400 User field. The password
value is visible during data entry. The password will be encrypted immediately upon clicking in
any other cell on the list.
Activate - Required Field
This field denotes if the system is currently one of the participating systems when Print Server is
started. The record is activated if a check mark is denoted in the box.
Edit Output Queue List
The Output Queue List maintains the details that will link system and output queue to a particular
forms processing method, FormDocs or Reform, and instructions on what to do with output
queues once processed by the Print Server. A output queue entry is created when you install the
software. There are no limitations to the number of output queues you can maintain in your list.
However, each time you start the Print Server it will monitor, download and print data from each
output queue that is activated. Creation of a new entry is as simple as clicking and entering data
into each cell of the line highlighted in yellow. Editing an existing entry is done by clicking in the
cell(s) that contain outdated or inaccurate data and changing the data. Changes or additions will
be committed to the database when you click on any cell in a different row than the one you are
editing.
A sample output queue list will look similar is shown below:
Sample Print Server Output Queue List
Output Queue - Required Field
Enter the name of an OS/400 output queue for Print Server to process.
Library - Required Field
Enter the OS/400 library name that contains the desired output queue enter in the field Output
Queue.
Description
Enter descriptive text that will tell you and your users which output queue is the desired output
queue.
AS/400 System or IP Address - Required Field
Enter a valid DNS system name or TCP Address for the desired iSeries system where the
reports are to be downloaded from. The value entered in this field must match an entry in the
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System List.
Activate - Required Field
When selected, this output queue will be included in the Print Server processing.
Output Format - Required Field
Select one of the given formats: FRM, PSC, HTF or FDC. Output format determines what
application will be used to process the outque. FRM will use Reform. PSC will create a
postscript printer file. HTF will convert spool files that have been stored as HTML to PDF format
for print. HTML to PDF Creator is a required product (additional fees apply) to use HTF option.
FDC will use FormDocs.
After Processing Option
Determines what will happen to the spool file once the data has been processed. There are four
options:
0 - Do Nothing
WinSpool/400 Print Server will not change anything regarding this report. Be cautious
when selecting this option, as the output queue will remain active and will be processed
and reprinted each and every time the Print Server monitors this output queue.
1 - Mark Report
The OS/400 report User Data Value will be marked with a value of *SENT after a report
has been downloaded. This setting will cause the report server to skip the report on
subsequent download passes.
Note - this setting may not be desirable if you want to preserve values in the user data
field after a report has been downloaded. if so, use the move to another output queue
option instead.
2 - Delete Report
The OS/400 report will be deleted after it has been downloaded.
Note - This option should only be used after thorough testing of the report server
software. a better option is to move the report to another output queue after it has been
processed and clear the cleanup output queue once a week. This provides the ability for
a report to be moved back to its original output queue and downloaded again if
necessary.
3 - Move Report
The OS/400 report will be moved to the output queue entered in the field Move to Output
Queue after it has been downloaded. This is a good way to consolidate already
downloaded reports into a single output queue for cleanup purposes. The cleanup output
queue can be cleared once every day or every few days.
Numeric values shown to the left of the option denote the actual value that will be stored in this
field.
Move to Output Queue
Enter the name of the destination OS/400 output queue to be used for processed reports. All
reports that are processed from the output queue noted in the Output Queue field will be moved
to this output queue after processing.
Library
Enter the OS/400 library name that contains the desired destination output queue entered in the
field Move to Output Queue.
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Print Control - Required Field
Determines what will happen to the spool file once the data has been processed. There are four
options:
*FCFC
ANSI print control characters are included in downloaded reports. This option can be
used when reports are sent to a COLD system.
*NONE
No print control characters are included in downloaded reports.
*PRTCTL
Space/Skip print control characters are included in downloaded reports.
Note - WinView/400 requires the use of the *PRTCTL option to accurately recreate
space/skip information. All of the other RJS converters require the print control
characters as well.
Edit Print Output Directory List
The Print Output Directory list maintains the detailed instructions for qualifying spool files,
restricting data to download, merging data and printing forms.
A sample Print Output Directory List is shown below:
Sample Print Server Print Output Directory List
Output Queue
Enter the name of an OS/400 output queue for Print Server to process.
Library
Enter the OS/400 library name that contains the desired output queue enter in the field Output
Queue.
AS/400 System or IP Address
Enter a valid DNS system name or TCP Address for the desired iSeries system where the
reports are to be downloaded from. The value entered in this field must match an entry in the
System List.
Output PC Directory
All downloaded reports will be saved to this directory. Enter a valid PC directory path, either
local or LAN. WinSpool/400 Print Server will not create this directory. If it does not exists, you
must manually create the directory.
Output PC Directory Desc
Enter descriptive text that will tell you and your users which directory will be used to store report
outputs.
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Activate
When selected, this output queue will be included in the Print Server processing.
Output File Prefix
The Output File Prefix field is used to hold a 20-character prefix for the output file name. The
Output file Prefix must reflect the name of the form template to be used, either through a
variable or be entering a specific template name. This prefix will become the first 20 characters
of the output PC file name. Print Server software supports long file names.
File Counter
The File Counter field is used to hold a 7-character numeric counter for the output PC file name.
This field will become the second half of the output PC file name. the minimum value allowed is
0 and the maximum value allowed is 9999999. This value is automatically incremented when a
report is downloaded and will automatically reset to zero if the value reaches its maximum.
Print Copies
Enter the desired number of copies to print. You must enter a value of one or higher. If you
leave the Print Copies field empty, then your reports will not print.
Number of Pages to Stack
If you want to put multiple report pages onto one form page specify the number of report pages
to stack together onto a single form page. This option is similar in concept to printing multiple
rows of labels on one page.
Use Extended Report Select
When enabled, a check mark will be displayed in the box; you can further qualify which spool
files will be downloaded from the desired output queue. Use Spool File Name, Spool User Data,
Spool Job Name and Spool Form Type fields to define the report selection criteria.
Spool File Name
Enter a specific spool file to further qualify your report selection. By entering a spool file name in
this field you will restrict the report selection within the output queue to one spool file name.
Spool User Data
Enter specific User Data to further qualify your report selection. By entering acceptable User
Data value in this field you can restrict the report selection within the output queue to only
include those spool files that contain the desired User Data value.
Spool User ID
Enter a specific OS/400 User ID to further qualify your report selection. By entering an OS/400
User ID in this field you can restrict the report selection within the output queue to only include
those spool files that match the desired User ID.
Spool Job Name
Enter a specific OS/400 Job Name to further qualify your report selection. By entering an
OS/400 Job Name in this field you can restrict the report selection within the output queue to only
include those spool files that match the desired Job Name.
Spool Form Type
Enter a specific Form Type to further qualify your report selection. By entering a Form Type in
this field you can restrict the report selection within the output queue to only include those spool
files that match the desired Form Type.
Use Specific Search Criteria
When enabled, a check mark will be displayed in the box, the report pages will be filtered before
download based on the criteria set in the fields Criteria Text to Scan For, Number of Lines to,
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Starting Search Column and Ending Search Column.
Criteria Text to Scan For
Enter the specific text to use for filter criteria when searching report data; for example, entering
the text "Sporting Goods" will result in all pages that contain the note "Sporting Goods" to be
downloaded and printed. Search criteria are case sensitive.
Number of Lines to Check
The Number of Lines to Check field is used to speed up the text search. When a value, such as
10, is placed in the Number of Lines to field, WinSpool/400 will search just the first 10 lines of
each page looking for the desired text criteria thereby reducing search time by eliminating the
need to search the remaining lines of the report. If you know the placement of the search text
will always be within the first x number of lines, you can enter that value in this field.
Starting Search Column
The Start Search Column field is also used to reduce the time needed to complete a text search
by qualifying the columns to search in. This field is used in conjunction with Ending Search
Column field to specify a range of columns to search rather than looking in every column of the
report. If you know the starting column where the text criteria should be located in the report,
enter that value in this field.
Ending Search Column
The Ending Search Column field is also used to reduce the time needed to complete a text
search by qualifying the columns to search in. This field is used in conjunction with Starting
Search Column field to specify a range of columns to search rather than looking in every column
of the report. The defined range is inclusive, meaning that the noted starting column and ending
column are included in the search. If you know the ending column where the text criteria should
be located in the report, enter that value in this field.
Spool to Output Queue
When enabled, a check mark will be displayed in the box, the report will be re-spooled to a
different output queue on the iSeries.
Dest Output Queue
Enter the name of the destination OS/400 output queue to be used when re-spooling reports.
Qutq Library
Enter the OS/400 library name that contains the desired destination output queue entered in the
field Dest Output Queue.
Output Type
Specify the desired output type, PDF or PCL, when spooling to an output queue. This option is
only used when spooling back to an output queue.
Send to Destination
Enable this option if you prefer to save the file either on the IFS or a network drive rather than respooling the output.
Destination Directory Path
If you have enabled Send to Destination, use this parameter to provide the IFS or network path
where the file is to be stored.
User Field 1
This setting is currently not used by WinSpool/400 Print Server.
User Field 2
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This setting is currently not used by WinSpool/400 Print Server.
Additional Form 2
When you printed forms using a traditional impact printer often forms were multi-part; each a
different color and given to either separate departments or to the client. The fields Additional
Form 2, Additional Form 3, Additional Form 4 are used to mimic that process. By placing a PC
file name into the field - no path or extension, such as YellowForm, you will be given the
opportunity to switch paper, for example to yellow, and then print a second round of forms using
the same data. The Print Server will create a second file using your file name and then add the
appropriate path and file extensions in preparation for printing.
Additional Form 3
When you printed forms using a traditional impact printer often forms were multi-part; each a
different color and given to either separate departments or to the client. The fields Additional
Form 2, Additional Form 3, Additional Form 4 are used to mimic that process. By placing a PC
file name into the field - no path or extension, such as YellowForm, you will be given the
opportunity to switch paper, for example to yellow, and then print a second round of forms using
the same data. The Print Server will create a second file using your file name and then add the
appropriate path and file extensions in preparation for printing.
Additional Form 4
When you printed forms using a traditional impact printer often forms were multi-part; each a
different color and given to either separate departments or to the client. The fields Additional
Form 2, Additional Form 3, Additional Form 4 are used to mimic that process. By placing a PC
file name into the field - no path or extension, such as YellowForm, you will be given the
opportunity to switch paper, for example to yellow, and then print a second round of forms using
the same data. The Print Server will create a second file using your file name and then add the
appropriate path and file extensions in preparation for printing.
Swap User Data
The Swap User Data field is used when re-spooling the report to the iSeries; User Data values in
the spool file are replaced with one of the values listed below. The Swap User Data value allows
various RJS products, such as Batch Report Server and Email Report Server, to filter on the new
User Data values. In version 1.0.22 we added the ability to swap user data value with any of the
following when re-spooling to the AS/400. This allows the Batch Report Server, Email Report
Server or other products to filter on the new values set by the user. Available swap values are:
@NONE
No changes to User Data will be made when re-spooling.
@FORMTYPE
Form Type will be set in User Data.
@JOBNAME
Job Name will be set in User Data.
@SPOOL
Spool File Name will be set in User Data.
@USERDATA
User Data will be set in User Data. The same can be accomplished by entering @NONE
@USERID - User ID will be set in User Data.
Swap Form Type
The Swap Form Type is similar to the Swap User Data field, the difference being that the
entered values will be used to change the re-spooled report Form Type.
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@NONE
No changes to User Data will be made when re-spooling.
@FORMTYPE
Form Type will be set in Form Type.
@JOBNAME
Job Name will be set in Form Type.
@SPOOL
Spool File Name will be set in Form Type.
@USERDATA
User Data will be set in Form Type. The same can be accomplished by entering @NONE
@USERID - User ID will be set in Form Type.
Hold/Release Spool
Select *YES to place the spool file status to Hold or *NO release the spool file for deletion. This
option is only used when spooling back to an output queue.
Save Spool After Printing
Select *YES to preserve the spool file after completing the printing process or *NO to delete the
spool file. This option is only used when spooling back to an output queue.
Windows Printer for HTML/FormDocs Printing
Select Windows printer or document conversion utility from the drop-down list.
After Processing Option***
If you want to re-spool the file during the printing process specify what should happen to the file
once it has been printed. There are four options:
0 - Do Nothing
WinSpool/400 Print Server will not change anything regarding this report. Be cautious
when selecting this option, as the output queue will remain active and will be processed
and reprinted each and every time the Print Server monitors this output queue.
1 - Mark Report
The OS/400 report User Data Value will be marked with a value of *SENT after a report
has been downloaded. This setting will cause the report server to skip the report on
subsequent download passes.
Note - this setting may not be desirable if you want to preserve values in the user data
field after a report has been downloaded. if so, use the move to another output queue
option instead.
2 - Delete Report
The OS/400 report will be deleted after it has been downloaded.
Note - This option should only be used after thorough testing of the report server
software. a better option is to move the report to another output queue after it has been
processed and clear the cleanup output queue once a week. This provides the ability for
a report to be moved back to its original output queue and downloaded again if
necessary.
3 - Move Report
The OS/400 report will be moved to the output queue entered in the field Move to Output
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Queue after it has been downloaded. This is a good way to consolidate already
downloaded reports into a single output queue for cleanup purposes. The cleanup output
queue can be cleared once every day or every few days.
4 - Use Output Queue Level Entry
After-processing action will use the default action that is specified in the output queue
level for the spool file.
Numeric values shown to the left of the option denote the actual value that will be stored in this
field.
Move to Output Queue***
Enter the name of the destination OS/400 output queue to be used for processed reports. All
reports that are processed from the output queue noted in the Output Queue field will be moved
to this output queue after processing.
Library***
Enter the OS/400 library name that contains the desired destination output queue entered in the
field Move to Output Queue.
*** The noted parameters can also be found in the Edit Output Queue List records. If you
specify After Processing Options for both the Output Queue and the Print Output
Directory, the values found in the Edit Print Output Directory List will take precedence
if the Print Output Directory - After Processing value is set to either 4 (Use Output
Queue Level Entry) or leave the field blank and specify Move to Output Queue and
Library.
Run
This section contains a description of each option found on the Run menu. These menu options
are only valid for RJS Reform software clients.
Form Designer
The Form Designer option calls the Reform Form Designer program. Currently, this option
should only be used if you are a long-time RJS Reform software user.
Spooler
The Spooler option calls the Reform Spooler program. Currently, this option should only be used
if you are a long-time RJS Reform software user.
Log
This section contains a description of each option found on the Log menu.
View Log
The View Log option displays the WinSpool/400 Print Server log file. Print Server activities
continue to be appended to the end of the log file until you clear the file using the menu option
Clear Log. Log file includes download pass start/stop times, success/failure of spool list retrieval,
report download, report conversion and printing details. The log file is viewed using the
application noted in the Editor setting, typically Notepad. Below is a sample of a download log
file:
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Sample Print Server Log File
Clear Log
The Clear Log option will remove all log entries from the Print Server log file. When the option is
selected you will be prompted to confirm the clear request.
Help
This section contains a description of each option found on the Help menu.
Contents
The Contents option is currently unavailable. In the future, this menu option will provide you with
on-line help.
About
The About option displays WinSpool/400 Print Server version information and RJS Software
Systems contact details. Software version information is helpful when you call our support staff.
A sample of the screen is shown below:
Print Server Help About Screen
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FAQs
This Section is designed to provide you with answers to frequently asked questions regarding
Electronic Forms.
Inserting Barcodes into a Form
Q. How do I insert barcode images into my form based on actual spool data?
A. The process of inserting dynamic barcode images into a form is similar to that of
inserting dynamic pictures, such as logos. Basically, all you need to do is create a field that
is defined as a barcode in your Text Layer Report and map that field to a field in your
FormDocs template. However, there are some nuances that should be noted. There are
many types of barcode that can be defined. The most common choice is type "3 of 9".
Several of the other barcode types require very specific values in the field data before a
barcode will be displayed. You must also have a field in the FormDocs template that is
formatted as a picture field. Below are the basic steps to using barcodes in your electronic
forms.
Quick Steps to Using Barcode in Electronic Forms
1. Create a field to display the barcode in your FormDocs Template. The field properties
should include a Format Type of Picture.
2. Create a field in Text Layer Designer that is defined with field properties enabling
barcode. Field name must reference the picture field defined in the FormDocs template.
A sample of the field properties is shown below:
Change Form Pages Dynamically
Q. How can I print a summary page at the end of my invoices?
A. Use a FormDocs script to dynamically change the standard invoice form to a
summary form at the end of the invoice printing. FormDocs includes a scripting language
called Forms Automation Basic (FAB) which is very similar to Microsoft Visual Basic.
Contact RJS Software Systems Support staff for code samples and help in customizing your
invoice print session.
Duplex Printing
Q. How do I print using duplex mode?
A. To keep your printing environment flexible you should create a second instance
of the print driver that will be used for duplex printing. Set the properties of the new print
driver description to permanently print in duplex mode. Next, open Print Output Directory
List in Electronic Forms Print Server and select the newly-defined print server in the field
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Windows Printer for HTML/FormDocs Printing.
Advanced Form Control with Scripting
Q. The standard calculations and field properties provided in FormDocs does not meet
my needs when creating certain complex forms. What can I do?
A. FormDocs includes a scripting language called Forms Automation Basic (FAB) which
is very similar to Microsoft Visual Basic. Contact RJS Software Systems Support staff for
code samples and help using FAB scripting language. Also, refer to the FormDocs on-line
help for more information on FAB.
Spooling Form Output
Q. How can I send Electronic Form Print Server output files to an output queue on the
iSeries?
A. Sending output files to an output queue is accomplished through four key Print
Output Directory List settings: Spool to Output Queue, Dest Output Queue, Outq Library and
Output Type. By enabling the option Spool to Output Queue, Electronic Form Print Server
will look to the values in the remaining three fields to determine the destination, location and
output type of the new spool file. The fields Hold/Release Spool, Save Spool After Printing
and Windows Printer for HTML/FormDocs Printing are used to control the processing of the
spool file once placed in the output queue. Below are basic directions to send Electronic
Forms Print Server output files back to a spool file on the iSeries.
Quick Steps to Send Output File to Spool File
1. Enable Spool to Output Queue option in the Print Output Directory List.
2. Enter the desired Dest Output Queue to place the spool file.
3. Enter the OS/400 library that contains the output queue in the Outq Library field.
4. Select the desired Output Type: PDF or PCL.
5. Select the desired Hold/Release Spool option: *NO or *YES. By selecting *YES, the spool
file will be printed immediately.
6. Select the desired Save Spool After Printing option: *NO or *YES. By selecting *YES the
spool file will be saved after printing and available to be archived. By selecting *NO the
spool file will be marked for deletion.
7. If you selected an Output Type of PDF, you must ensure that the field Windows Printer for
HTML/FormDocs Printing is blank. Any other value will cause the operation to fail.
8. If you selected an Output Type of PCL, you must select a PCL print driver in the field
Windows Printer for HTML/FormDocs Printing. If your Print Server PC does not have a
PCL print driver, create a faux PCL print driver. This can be accomplished by adding a
printer to the Window's environment that uses a PCL print Driver; we recommend
selecting a driver from the HP Laser Jet 4000 series - 4100PCL works best.
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Understanding WinSpool/400 Data Areas
As you integrate WinSpool/400 with your applications you may encounter times to change
WinSpool/400 values that are stored in data areas on the iSeries. Some of the values contained
within the WinSpool/400 data areas may need to be adjusted and are described in this section.
Most data area values can be altered by using specific WinSpool/400 commands. Whenever
possible, use a WinSpool/400 command if available to modify data area values. Detailed
command descriptions can be found in the section OS/400 Server Commands. It is
recommended that those data areas that are not included in this list should not be modified by
your applications. Data areas can be found in the library RJSIMAGE.
Data Area Information
Data Area
LPAR
Description
Stores LPAR access codes.
Possible Values: 0 or 1. This is a character value with a length of 1.
Default Value: 1
MAILKEY
Stores mail key code.
Value Type: This is a decimal value with a maximum length of 9 and zero
decimal places.
Default Value: 1
MAILRPTUSR
Stores clear user data parameter for the MAILRPT command that determines
if option is enabled or disabled. When enabled, user data will be cleared at
the time the MAILRPT command is executed.
Possible Values: *NO - Disabled, *YES - Enabled. This is a character value
with a length of 4.
Default Value: *NO
QLISTLEN
Stores spool list API length.
Value Type: This is a decimal value with a maximum length of 5 and zero
decimal places.
Default Value: 88
QUSRSPLA
Stores spool API length for QUSRPLA.
Value Type: This is a decimal value with a maximum length of 5 and zero
decimal places.
Default Value: 1411
VERSION
Contains the current WinSpool/400 library version information. Software
version can be used by RJS support staff to diagnose problems.
Value Type: This is a character value with a length of 50. A valid entry could
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be 'WinSpool/400 V3.48'.
WINSPL32
Stores the WinSpool/400 32-bit APPC user authorization code.
Value Type: This is a character value with a length of 50.
Default Value: blank
WINSPOOL
Stores the WinSpool/400 16-bit APPC user authorization code.
Value Type: This is a character value with a length of 50.
Default Value: blank
WINSPTCP
Stores the WinSpool/400 32-bit TCP/IP authorization code.
Value Type: This is a character value with a length of 50.
Default Value: blank
WSPBSRV
Stores the WinSpool/400 Batch Report Server authorization code.
Value Type: This is a character value with a length of 50.
Default Value: blank
WSPCCSID
Stores OS/400 CCSID code page to use in translation.
Value Type: This is a character value with a length of 5.
Default Value: 65535
WSPDISTILL
Stores the WinSpool/400 Postscript to PDF Converter authorization code.
Value Type: This is a character value with a length of 50.
Default Value: blank
WSPDIW
Stores the WinSpool/400 DataImport report converter command.
Value Type: This is a character value with a length of 50.
Default Value: blank
WSPEFORM
Stores the WinSpool/400 Electronic Forms authorization code.
Value Type: This is a character value with a length of 50.
Default Value: blank
WSPESRV
Stores the WinSpool/400 Email Report Server authorization code.
Value Type: This is a character value with a length of 50.
Default Value: blank
© 1995-2005 RJS Software Systems
113
RJS Electronic Forms
WSPFSRV
Stores the WinSpool/400 Fax Report Sever authorization code.
Value Type: This is a character value with a length of 50.
Default Value: blank
WSPISRV
Stores the WinSpool/400 Intranet Report Server authorization code.
Value Type: This is a character value with a length of 50.
Default Value: blank
WSPLDBCS
Stores the parameter that is used to determine if double byte data should be
allowed via TCP/IP. If enabled, double-byte data can transmitted via TCP/IP.
Possible Values: *NO - Disabled, *YES - Enabled. This is a character value
with a length of 4.
Default Value: *NO
WSPMAILKEY
Stores unique Mail Key data area - used by WSPMAILKEY.
Value Type: This is a decimal value with a maximum length of 7 and zero
decimal places.
Default Value: 1
WSPNOTES
Stores the WinSpool/400 Lotus Notes Report Server.
Value Type: This is a character value with a length of 50.
Default Value: blank
WSPPCL
Stores the WinSpool/400 AFP-PCL report converter authorization code.
Value Type: This is a character value with a length of 50.
Default Value: blank
WSPPCLPDF
Stores the WinSpool/400 AFP-PDF report Converter authorization code.
Value Type: This is a character value with a length of 50.
Default Value: blank
WSPPCLTIF
Stores the WinSpool/400 AFP-TIFF Report Converter authorization code.
Value Type: This is a character value with a length of 50
Default Value: blank
WSPPSRV
Stores the WinSpool/400 PDF Report Server.
Value Type: This is a character value with a length of 50.
Default Value: blank
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Stores the parameter that determines if DDS should be used when creating
work files.
Possible Values: *NO - Disabled, *YES - Enabled. This is a character value
with a length of 4.
Default Value: *NO
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